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Introduction

1. Introduction

The AxTrax AS-525 Access Control System®is a complete software
managementsystem for use with AC-215, AC-225 and AC-525 Access
control panels.

The AxTrax AS-525 Access Control System®is user-friendly, intuitive, and rich
in functionality. The system can manage up to 30,000 users and offers
complete control overup to 4092 doors (with MD-D02reader expansion
board). Using AxTrax AS-525, configured doors by area and time, for
differenttypes of personnel and for varying alarm situations.

The AxTrax AS-525 Access Control System®is capable ofintegrating with
Video Surveillance software “ViTrax”. The main purpose of the integration
isto enable videorecording based on access control events and
convenient playback.

This Manualis compatible with AxTrax AS-525 software Version 00.03.17
and above, as well as ViTrax Version 1.6.15.15382.

1.1 System Features

The AxTrax AS-525 makesit possible to control and monitor every aspect of
access control on a site. The system includes an in-built software se curity
system that controls accessto the system database and logs all
operations performed. In addition, the system boasts the following
Professional Grade Features:

Free basic level-0 serversoftware license forup to 64 panels (ACU’s).
Three incrementallicense levels can be activated by buying a
Rosslare HASP key (CD-ROM is provided with the package)
User-friendly PC software with intuitive layoutreduces complexity of
access control

Manages userdata, photo and information fields, accessrights,
alarms, strike time, and door mode, allfrom one centrallocation
Producesreports from acquired data, such as entry and exit times,
and any types of alarms, by user,location, and time

Availablein alarge variety oflanguages

Compatible with additional software modules from Rosslare fortime
and Attendance and photoID card development

Backward compatibility with VeriTrax AS-215 and AS-225

Access Control

Access groups define accessrights for every part of the site. Accessrights
are time dependent—for example, usersin the "Mornings Only" access
group could have accessto certain areas of the site between 9am and
12pm only.

Every useris assigned to an access group. The system also stores an
identification photograph and personal details foreach user and user
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specific accesssettings, such as Antipassback immunity; require ments for
an extended open doorperiod; configurable special priviieges and
triggered outputs.

Access Monitoring

The AxTrax AS-525records every attemptto open a door within the site.
Status mapsshow the state of every part of a facility, while an Eventslog
records complete details of every time access granted or denied for
every door on site while also monitoring possible doortampering and
forced entries.

The AxTrax AS-525 can also produce a variety of accessreports,including
usagereports, attendance records and roll calls. Using the AxTrax Report
Wizard, users can design their custom reportsto meet theirspecific needs.

Software Security

Accessto the AxTrax AS-525 software is password controlled. Itis possible
to grant different operatorsrestricted security rights, with accessto only
specified elements of the system or withread-only access.

1.2 AxTrax Server and Client

The AxTrax AS-525 system includes both the AxTrax AS-525 Server and the
AxTrax AS-525 Client software.

AxTrax AS-525 Servershould be installed on the computerthat will control
the Access control panels and manage the database. Itincludes a full
suite of administrator functions, including the ability to change panel
network parameters, download new firmware to individual access control
panelsand manage the AxTrax AS-525 database.

Additional computers can use the AxTrax AS-525 Client software, which
connectsto the panel network through the AxTrax AS-525 Server. The
AxTrax Client has a limited operation set, and can only send orreceive
information from Access Control panels when the AxTrax Serveris
operating and connected to the panel network.

One AxTrax AS-525 Server can serve an unlimited number of AxTrax AS-525
Clients.

1.3 Using this User Guide

This user guide provides allthe information required to start working with
the AxTrax AS-525, referto the AC-215, AC-225 orthe AC-525 hardware
manuals for wiring and installation.

How to install the AxTrax AS-525 on a computer

The basic functionality of the AxTrax AS-525

How to set-up the AxTrax AS-525 for a new site

How to monitor and manage a site using the AxTrax
AS-525

AS-525 AxTrax Software Installation and User Guide Page 6
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2. Specifications and Requirements

2.1 System Capabilities

General
Software Architecture Client - Server
Database type SQL Server 2005
Max. of Users 30,000
Max. Access Groups 30,000
Max. Number of Time Zones 32
Max. Cards per User 16
Max. Number of Doors 4092
Max. Access Control Panels 1023
Antipassback e Timed
e Door
e Global-Across an entire Facility
International Holiday Support 64
Networks
Max. Number of Networks 1023
Supported Access Control Panel e AC-215
Models e AC-215 (SPV)
e AC-225
e AC-225 with MD-1084
e AC-225 with MD-D02
e AC-525 with MD-1084
e AC-525 with MD-D02
Panel Networks communication o Serial (RS-232)
interface e TCPP
e Modem
Communication speed 9600-115200 bps
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2.2 System Requirements

AxTrax AS-525 System Minimum Requirements

Operating System Windows XP SP2, Windows Vista

Processor Pentium 4 or better

Memory 256 MB (512 MBrecommended)

Network LAN card required for TCP/IP
networking

Hard Disk space 1.5 GB (500 MB free space)

SQL Express Server Minimum Requirements
(SQL ServerExpressis not alwaysrequired.See Choosing an SQL Server,
page9.)

Operating System Windows XP SP2, Window Server
2003, Windows Vista

Processor Pentium 4 or better

Memory 256 MB (512 MBrecommended)

Hard Disk space 600 MB (256 MB free space)

HASP USB Key Requirements

1-64 active panels HASP key notrequired

65-256 active panels Level 1 HASP key required
257-512 active panels Level 2 HASP key required
513-1023 active panels Level 3 HASP key required

AS-525 AxTrax Software Installation and User Guide Page 8
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3. Installation

The AxTrax AS-525installation CD-ROM includes all the set-up filesrequired
torun the AxTrax Server or Client on a computer.
The installerincludes the following ele ments:

Microsoft™ SQL Server 2005 Express

Microsoft™.NET 2.0 Framework

AxTrax AS-525 Access Control System (Server or Client version)
HASP key controller (AxTrax Server only)

===w| Note:
!'m] SQL Server Express and the Microsoft .NET Framework are pre-
requisite software and are notinstalled unlessrequired.

3.1 Choosing an SQL Server

The AxTrax Server operates using an SQL database.If there is already an
SQLserver available onyour computer network, use it to run the AxTrax
database.

Alternatively, install the Microsoft SQL Server Express on the computerthat
will be used asthe AxTraxserver.

===w| Note:
I'|||] Do notinstallthe SQL server for AxTrax Clientinstallations. AxTrax
Clients connectto the AxTrax Server database.

3.2 Starting the AxTrax Installer

Install the AxTrax AS-525 Access GControl System using the installation CD-
ROM.

To begin installing the AxTrax AS-525:
1. Insertthe CDinto your computer's CD drive.

2. Open My Computer, double-click onthe CD drive icon and then
double-click the AxTrax AS-525 setup file.

If the setup detects a previous version of AxTrax AS-525, a prompt will
appear asking if you wantto upgrade AxTrax AS-525to the newer
version. Note that upgrading to the newer version will only use current
database information. Downloading of panelinformationisrequired
afterupgrading the AxTrax AS-525 version.

Ifthereisno SQL serverinstalled, the Installation Requirements window
opens.
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InstallShield Wizard

ArTran 45-525 requires that the following requirements be installed on your computer prior
1 toinstaling this application. Click QK. to begin instaling these requirements:

| Status Requirement
| Estracting Microsoft SOL Server 2005 Express

Estracting. Microsoft SOL Server 2005 Express. SOLEXPR.EXE

Cancel

Figure 1: Installation Requirements window
3. Click Install.

Ifthere isno SQL serverinstalled, the following dialog appears: “AxTrax
AS-525 optionally uses Microsoft SQL Server 2005 Express. Would you
like to installit now?”

If you are installing AxTrax Client orif there is already an SQL server
available on the computer network, click No.

Otherwise, click Yes to install SQL Server Express.

===w| Note:
-
!'m] Install AxTrax Server on the computerthat will connect to the
Access control panelsand manage the database.

Install AxTrax Client on any additional computers.

4. Ifthe Microsoft .NET 2.0 Frameworkis notinstalled on the computer,
the following dialog appears: “AxTrax AS-525 optionally uses Microsoft
® .NET 2.0 Framework. Would you like to installit now?”

Click Yes to install Microsoft .NET Frame w ork.
Follow the on-screen instructionsto complete the installations.

3.3 Installing AxTrax AS-525

Afterthe installerhas added any pre-requisite software to the system, the
AxTrax AS-525 Install Shield Wizard installs the software.

AS-525 AxTrax Software Installation and User Guide Page 10
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InstallShield Wizard

Preparing to Install...

ATran AS:525 Setup is preparing the InstalShisld
wizard, which will guide you through the program setup
process. Please wait

Checking Dperating System Version

(AiANRRRANRANRRRRR

Figure 2: Install Shield Wizard

To Install AxTrax AS-525:
1. Wait while AxTrax AS-525 preparesto install.
The Welcome to the Install Shield Wizard window opens.

i Axlrax AS-525 - InstallShield Wizard g|

welcome to the Installshield Wizard for
AxTrax AS-525

The InstallShield{R) Wizard will install AxTrax A5-525 on your
computer. Ta continue, click Mext.

WARMIMG: This program is protected by copyright law and
international treaties,

< Back fomext> [ Cancel ]

Figure 3: Welcome to the Install Shield Wizard window
2. Click Next.
The Select Database Server window opens.
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1 AxTrax AS-525 - InstallShield Wizard

Database Server

Select database server and authentication method b
=
Select the database server to install to from the list below or click Browse to see a list of all
database servers, You can also specify the wary to authenticate your login using your current., .

In case of SqlExperss you need to add the instance name "Veritrax' to the computer name,
For example: "Computer 11 Veritrax'
Database Server:

Conneck using:
(O windows authentication credentials of current user
(%) Server authentication using the Login ID and password below
LognIDi  |sa
Password:  [srioerr
[ <Back || Mests | [ Cancel |

Figure 4: Select Database Server window
Selectthe database servername.

On AxTrax Clientinstallation itislikely thatthe database server was
installed on another PC, click Browse to selectthe database server
location.

Ifthe database serverused wasinstalled from VeriTrax setup program
("SQL Server express') than the instance name "\VeriTrax"should be
added tothe database computername

Setthe "Connectusing"to the default option ("Server authentication
using the login ID and password below") The only condition for
setting "Windows authentication"is when using existing SQL database
NOTinstalled from VeriTrax setup, and only if it was installed using
Windows authentication.

Click Next.
The Setup Type window opens.

i AxTrax AS-525 - InstallShield Wizard &3]
Setup Type

Choose the setup type that best suits your needs, =
Please select a setup type.

®5server

All program features wil be installed. (Requires the most disk.
space.)

Oclient

Oty clienit tools wil be installed. (Required server installation
beFore.)

[ <gack  J[ wewt> | [ cancel |

Figure 5: Custom Setup window
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7. Toinstall AxTrax Server, select Server from the list.
_Or_

To install AxTrax Client, select Client from the list.

i

AxTrax must be first installed as AxTrax Server.
Installing AxTrax Clientsis optional. It can be useful for monitoring
the system from more than one PC.

8. Click Next.
The Destination Folder window opens.

1% AxTrax AS-525 - InstallShield Wizard

Destination Folder 3
Click Mext to install b this folder, or click Change to install ta & different folder. i
If" Install AxTrax AS-525 to:
\j CilProgram FilesiRosslare| fxTrax A5-525|
[ «Back | Hextz | [ cancel |

Figure 6: Destination Folder window

9. Toselectanew destination folder for AxTrax AS-525, click Change
and browse to the required folder.

10. Click Next.
The Ready to Install window opens.

18 AxTrax AS-525 - InstallShield Wizard X

Ready to Install the Program X
The wizard is ready ko begin installation. S
Click Instal to begin the instalation,

TF you wark ko review or change any of your installation settings, click Back. Click Cancel ko
et the wizard,

[ <pack [ mnstal | [ Cancel |

Figure 7: Ready to Install window
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1.

Click Install.
The installation process begins.

i AxTrax AS-525 - InstallShield Wizard

Installing AxTrax AS-525

The program Features you selected are being installed.

take several minutes,

Status:

Please wait while the Instalishield \Wizard installs AxTrax AS-525, This may

Figure 8: Installing AxTrax AS-525 window

12. When the installation is complete, the Install Shield Wizard Completed

13.

window opens.

i AxTrax AS-525 - InstallShield Wizard

InstallShield Wizard Completed

A5-525, Click Finish to exit the wizard,

The InstallShield Wizard has successfully installed AxTrax

Figure 9: Install Shield Wizard Completed window

Click Finish and restart the computerifrequested.

During Serverinstallations, a dialog appears while the HASP key

protection software isinstalled.

The AxTrax AS-525 Access GControl System is now fully installed on the

computer.

AS-525 AxTrax Software Installation and User Guide
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3.4 Firewall Settings

Internal firewall settings may prevent the AxTrax Server connecting to the
SQL database orto panel control units using TCP/IP.

For more information on how to configure a firewall, see Appendix A.
Firewall Configuration, page 89. Contact yoursystem administrator or
Rosslare Technical Support for further guidance.

3.5 SQL Server Settings

Afterinstalling the AxTrax, verify thatthe SQL serverservice on the
computerisrunning and setto the required installation.

For more information on SQL servers settings, see Appendix B, page 94.

-—- Note:
!'m] Ifthe SQL Express 2005 isinstalled (part of the installation package),
the installation must be on the same Windows XP user accountthat

is being used for AxTrax.

3.6 Camera Installation & Requirement Steps

AxTrax AS-525 can connect with single or multiple ViTrax Serversinstalled in
a LAN or WAN configuration (up to 10 ViTrax Servers are supported).

-—- Note:
!'m Make sure to check AxTrax AS-525 and ViTrax version comp atibility.

To Install ViTrax Server and Client applications, referto the ViTrax Software
manual.

-—- Note:
I'm When installing the AxTrax AS-525, make sure that the ViTrax Server
has already beeninstalled onthe same PC (nolicense required for

that ViTlrax Server).

To Install Cameras:
1. Activate ViTrax Server and Client (see Vilrax Software manual).
2. Define ViTrax Servers (see 64).

3. Define communication of AC-525 camerasto the ViTrax Server
(see Defining communication of AC-525 cameras to the Vilrax
Server).

4. Activate AxTrax AS-525 and configure it (see System Overview and
How to Set Up a Site).

Page 15 AS-525 AxTrax Software Installation and User Guide
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4, System Overview

The AxTrax AS-525is controlled through an easy to use interface, with a
tree-view list of all aspects of the site set-up and a toolbarforstandard
operations.

4.1 Starting the Software

This section explains how to start the software and login to the main
window.

To start the AxTrax AS-525:

1. Click on the AxTrax AS-525icon on the desktop, orselectthe program
from the Rosslare folderin the Start menu.

i
Figure 10: AxTrax AS-525 Access Control System Icon
The AxTrax Software login dialog appears.

8 #xTrax 45-525 Software ¥ 0.03.16 X

% Plaaso chack name and onbr passmand

Diparsior nams
|administlatol j

Passward

o | e |

Figure 11: AxTrax Software Dialog box

2. Selectan Operatorname and enter a password.

===w| Note:
!'m] By default, the Administrator operator password is "ad min".
The SW versionsin the screenshots are exemplary only

3. Click OK.
The main AxTrax AS-525 window opens.

AS-525 AxTrax Software Installation and User Guide Page 16
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4.2 The AxTrax AS-525 Main Window

All'the central functionality of the AxTrax AS-525is available from its main
window.

£ (4
W DepatrmentsLsns

) Hokdays

& Oosistors

AX[rax
|

Coppegfd [} 208 Rissslane E rdempanes Lad

B Serve admesivalon et T

Figure 12: AxTrax AS-525 Main window
The AxTrax AS-525 Main window is divided into five sections:

1 Menu Controlsthe general operation and set-up of the software. For
Bar more information, see Menu Bar, page 18.

2 Toolbar Use the toolbariconsforthe key tasksrequired in managing
access control across a facility. The available icons change
according to the view selected. For more information, see
Toolbar, page 19.

3 Tree The tree view allows users to configure, monitor and control
View every aspect of a facility access control. For more
information, see Tree View, page 21.

4 Display Displays allite ms within the tree view selected element.
Area

5 Status Displays general statusinformation such as: Operatorname,
Bar client orserver mode, system readiness, system download,
date and time.

Page 17 AS-525 AxTrax Software Installation and User Guide
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4.3 Menu Bar

The menu bar controlsthe general operation and set-up of the software.

File Menu
The File menu has four options:
Menu Description
Logon Log onto the AxTrax AS-525 system.

Whenyoulog on asanew Operator, the previous
Operatorwillbelogged out.

Logoff Close the current Operatoraccount.
The AxTrax software is minimized to the taskbar.

SQL ServerLogon Log ontothe SQL database server.

ViTrax Server Log on to the ViTrax server.
Exit Exit the AxTrax AS-525 software.
Tools Menu

Use the Tools menu to manage the database and setsoftware
preferences. The menu hasthree options:

Menu Description

Database Openthe Database window to backup the database
orsetascheduled backup and toimport or export the
AxTrax AS-525 and/or VeriTrax AS-215/AS-225
configuration states and Eventslogs.

Options Setsoftware options and preferences, including
national holidays, event highlighting, pop-up alarms,
custom userinformation fields and Reports settings.

Import Data Import userinformation from an Excel spreadsheet file.
Help Menu
The help menu has one option:

Menu Description

About Software version information.

AS-525 AxTrax Software Installation and User Guide Page 18
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4.4 Toolbar

The toolbar controls key tasksrequired to manage access control across a
facility. When a new elementisselected from the tree view, the toolbar
icons change to suit the selected element.

The following toolbaricons are available:

General lcons

Icon

Name

Description

1

Open DoorManually Opensthe Door Manual Operation

window. See Controlling the Door
Manually, page 70.

: Print Send the current display area view to the
= printer.
a New Create a new element of the selected
type.
] Edit Edit the selected element.
o Delete Delete the selected item.
adl Delete All Remove all users or cards from the
selected list.
Events Icons
Icon Name Description
Pause Pause the display of eventsin the display area.
il New events will be shown again when the
Pause buttonis clicked a second time.
View Events Displays all Events that occurred within the last
:Jl within the last hour. Click the drop-down arrow to change
Hour the view.
View Events Displays all Events that occurred within the last
IJl within the last day. Click the drop-down arrow to change the
Day view.
View Events Displays all Events that occurred within the last
EJl within the last week. Clickthe drop-down arrow to change
Week the view.
View Periodical Displays allEventsthat occurred within a
] Events selected period. Click the drop-down arrow to

change the view.

Page 19
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[E3]

View All Events

Displays all Events. Click the drop-down arrow
to change the view.

Antipassback

Opensthe Antipassback Forgive window,

E Forgive allowing the operatorto cancel an
antipassback restriction forthe selected user.

i Show User Opensthe User window forthe selected user.

& Clear Alarm Opensthe Alarm Details window, allowing the
operatortoresetthe alarm.

i Archive Opens Archive Camera Window forthe

= selected Video Stream.

Networks Icons

Icon

Name

Description

ey

Update Firmware

Send a firmware update to the selected access
control panel.

One Reader per

Displays new panel with single reader perdoor

| Door (with/without extension panel). See Adding
Access Control Panels, page 28.
Two Readers per Displaysnew panel withtworeadersperdoor
| Door (with/without extension panel). See Adding
Access Control Panels, page 28.
™ SetTime Setthe time on the selected Access Control
o Panel. See Setting the Time and Date, page 77.
Find Panels Find and update panels within the network. See

Detecting Panels Automatically, page 77.

i
u

Modem Manual

Opensthe Modem Status window, allowing the

= operatorto connect ordisconnectthe modem
and change the connection password.
-, Camera View a list of camera’s connected and assign
i camera’sto panels, page 66.
Panellcons
Icon Name Description
Manual Change the operation mode ofthereaders
ﬂ Reader onthe selected panel.See Changing the

Reader Mode, page 71.
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Icon Name Description

Control Qutput Change the settings forthe outputs on the
[: Manually selected panel. See Controlling Outputs
Manually, page 72.

ControlInput Change the settings forthe inputs on the

:] Manually selected panel.See Manually Disarming
Inputs, page 73.

a Control Siren Test the siren forthe selected panel. See
= Manually Testing the Siren, page 74.

Manually Update the selected panel. See Manual
"J Download new Download of Panel Data, page 78.

Panel Data

Manually Downloadsthe entire Panels Failed database.
| Download failed See Downloading Failed Data: page 79

Data

Departments\Users Icons

Icon Name Description
Q Find Users Search for a userinthe database.
4 User Counter  View current User count value.

See Testing User Counters: page 80

Reports Icons

Icon Name Description

| Produce Report Produce the selected report.

4.5 Tree View

The Tree View allows usersto configure, monitor and control every aspect
of a facility's access control network.

When the userselects an elementfrom the tree, its contents are shown in
the main display area and the toolbaricons change to suit the selected
element.

Events

The Eventslog displays alog of every time access was granted or denied,
for every dooron a site. Monitoring for potential doortampering orforced
entry,islogged and displays of internal system warnings, including Video
stream archive are saved to the ViTrax database.
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Status Map

The Status Map displays the status of every door,reader and alarmin the
facility on user-selected floor plans.

The system can display multiple nested status maps, allowing users to show
eitherthe complete access control network or a specific area in detail.

Networks

A networkis a group of up to 32 access control panels. The AxTrax Server
connectsto the panels acrossthe panelnetwork. The AxTrax AS-525 can
supportup to 1023 panel networks. For more information, see Defining a
Network, on page 26.

Note:
I |||] To work with 65 panels or more, a HASP se curity key must be

connected to the AxTrax Server machine.
See System Requirements, page 8.

Time Zones

Defines a weekly time period orset of time periods, for example, "Office
Hours" or"Out of Office Hours". Door accessrights, alarms and input and
output behaviorcan allbe setto behave differently within each Time
Zone. For more information, see Defining Time Zones, page 25.

Access Groups

An Access Group defines when eachreaderon the site will be available
for access. Allsite personnel are assigned to appropriate Access Groups.
For more information, see Creating Access Groups, page 39.

Input and Output Groups

Input and output groups defines sets of outputs orinputs thatshould be
managed together within a panel. For more information, see Configuring
the Inputs, page 38.

Access Areas and Global Antipassback

A facility can be sub-divided into several access areasin orderto
configure and manage it more effectively. Antipassbackrulescanbe
applied foreach access area to prevent one user's card or entry code
being used fortwo subsequent entries and to prevent a second entry
without a previous exit.

Creating Access Areas and Global Antipasshack Rules, page 50.
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Cards

Lists all cardsin the system with their statuses, and allows the manual or
automatic addition of cardsto the system. For more information, see
Defining Cards, page 41.

Departments and Visitors

Lists departments and users, as well as visitors. Every userisa member of a
department. Itis possible to assign each user a card and/or a PIN code,
set accessrights, personal details, and anidentification photograph for
each user.

Creates visitors with theirspecific associated rights.

For more information, see Defining Users and Departments, page 44.

Holidays

Defines annual holiday dates. Using Time Zones, itis possible to setspecial
access behaviorsfor holiday time.

Operators

Selected holiday dates can also be imported into the AxTrax AS-525
from Microsoft® O utlook®.

Operators are people with accessto the AxTrax software. The default
operatornames are administrator, engineer and security.

Different operators have wider or more restricted se curity rights, from
complete control overthe system to the ability only to view one section.
All Operator passwords are case-sensitive.

Reports

AxTrax can produce variousreports,including usage reports, attendance
records, visitors, and roll calls. The AxTrax Report Wizard allows users to
design theirown custom reports, based on theirneeds. For more
information, see Reports, page 75.
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5. How to Set Up a Site

Thissection outlines a suggested step-by-step process for configuring the
AxTrax AS-525 for a site.

Action Section
Define the Time Zones See Defining Time Zones, page 25.

Define a Network See Defining a Network, page 26.

Define and Configure an See Adding Access Control Panels,

Access Control Panel page 28.

Configure the Doors See Setting Door Properties,
page 33.

Configure the Readers See Configuring the Reader,
page 35.

Configure the Inputs See Configuring the Inputs,
page 38.

Create Access Groups See Creating Access Groups,
page 39.

Define new Cards See Defining Cards, page 43.

Set-up new Users See Defining Departments, Users, and

Visitors, page 45.

Define Access Areas and See Defining Access Areas and

Antipassback Antipassback, page 51.
Set Panel Links See Setting Panel Links, page 53.
Create a Status Map See Creating Status Maps, page 56.

-
(¢}
=

The AxTrax AS-525 system performs an automatic data download for any
parameterrelated to the hardware. If panels are connected and active,
"Downloading" willappearonthe status bar afterany downloaded
parameterchange."Ready" appears when download is complete,
howeverit may also appear after a failed download.

!'m Itisthe operators’ responsibility to verify thatthe download operation

succeeded orfailed. Thiscan be verified in the system eventlist or by
checking the download failed data manually,see page 79.
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5.1 Defining Time Zones

Atime zoneis a group of periods within a week. Door accessrights, alarms
andinput and output behaviorcan all be setto behave differently for
eachTime Zone. Many operations can automatically enable or disable
within a selected time zone.

The Time Zone Properties window displays the selected periods foreach
dayinthe week.Itis possible to set a maximum of eight different periods.

To set a new time zone:
1. SelectTime Zonesfrom the tree view.

Clickthe Newicon . onthe toolbar.
The Time Zones Properties window opens.

Time zone Properties E]

Deescription
|Ofice Hours

Stat | End | Sun | Mon | Tue | Wed | Thu | Fi | Sat | Hol
wiEms S S S A
s S S S S A
li_li_

li_li_

,i,i
’T,T

Clear All oK ‘ Cancel ‘

I B B T S N S R

Figure 13: Time Zone Properties window
The Time Zone Properties window contains the following fields:

Field Description

Description Entera name forthe time zone.

Start / End Enter a starttime and an end time foreach period.

Sun-Hol Selectthe days on which the time period is within the time
zone.

The "Holiday"day can be settoinclude national holidays.

Clear All Clear allthe time zone settings.
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2. Enteraname forthe time zone and setthe required time periods.
Click OK.

The window closes and the display area displays the new time zone.

- —-
!'"” Time settings can be copy-and-pasted between time zones.

Right-click on a time zone and select Copy from the shortcut
menu then Right-click on a second time zone and select Paste
from the shortcut menu.

5.2 Defining a Network

The AxTrax AS-525 communicates with each access control panel as part
of a network. A networkis a group of up to 32 access control panels.
The Network window includes the following information:

The network's name, address and status
The DIP switch settings forthe communication speed
The type of network connection and the connection settings

To access the network window:
1. Inthe Tree view, click Networks, and from the Network toolbar, click

New d

The Network window is displayed.

Description
MHetwork 1 M 1

¥ Enabled

Metwork type

Serial -

Serial Netwark

Com Port
COM1: -

Speed

9600 h

Advanced ‘ 0K | Cancel ‘

Figure 14: Network window
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The Network window contains the following fields:

Field Description

Description Entera name forthe network. The network address
forthe network is shown to the right of the network
name.

Enabled Enable the checkbox when the network is

connected and operational.

Network Type

Selectthe Network type: Serial, TCP/IP or Modem.
See Network Configuration, on
page 96.

Serial / TCP/IP /
Modem Network

Setthe connectiontype and speed.

ForTCP/IP connections, setthe IP Address.
See Network Configuration, on
page 96.

Configuration

Opensthe Configuration window to set
communication preferences. This button appears
when selecting a Modem or TCP/IP LAN network. For
more information, see Network Configuration, page
96.

Advanced

Setsthe Maximum Communication timeout for panel
response time; Setto "Slow"if panelresponse is not
consistent. This condition may occur due to busy
TCP/IP network or when connecting panelson a
WAN inremote sites

2. Enteraname forthe new Networkinthe Description box and select
the Enabled check box.

Selectthe Network type and setthe connection settings.

3. Fora Modem, click the Configuration button to set dialing
preferencesforthe computer's modem and the receiving modem.

4. ForaTCP/IPLAN, click the Configuration button to locate the
hardware on the local network.

For more information on how to configure an access control network,
see Network Configuration, page 96. Check with your system
administrator for more information, or contact Rosslare technical
support (see TechnicalSupport, page 103), Un-check the "Enabled"
checkboxif you wish to pause communicationto panels on the

network.
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!'m Access control panels connectto a TCP/IP network via a MD-N32

TCP to Serial converter or using the on board convertersin AC-225
or AC-525. Referto the relevant hardware installation guides for
more details.
5. Foralltypes of network, set the DIP switch on the Access control
panel hardware to match the diagram atthe top of the screen.

!'m Make sure to power-down and then power-up the panels after

changing DIP switch.

5.3 Adding Access Control Panels

Every networkis a cluster of access control panels. Each Panelcan be
configured using tworeaders perdoor when the door acts as both the
entrance and exitto an area of the site. In theirstandard form, each
access control panelhastworeadersanditcan be configured as either
assingle door withtworeaders or astwo doors with onereaderpereach
door. When using optional MD-D02 readers expansion board (supported
by AC-225 or AC-525) each panel willhave fourreaders and can be
configures asfourdoors panel.

Use tworeaders perdoorwhen one door acts as both the entrance and
exitto an area of the site. When only an entryreaderisrequired, use one
readerperdoor.

For example:

Use configuration with tworeaders perdoorsettoIN and OUT, to
produce attendance reports.

Use onereader perdoor configuration to controltwo doors with "IN"
readeronly (exiting the premises will be by REX switch or by
mechanical door handle only).

General Panel Settings

The Generaltab of the Door Controller Panel Properties window displays
the following:

The panel'saddress and status
The DIP switch settings forthe panel,
If panel expansion boards are installed:

The input and output connections forthe panel

The panel'shardware version
Referto AC-525 Hardware manual for further details on panel
configurations.
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To add a panel:

1. Inthe tree view, click on Networks.

The available networks are listed in the display area.

2. Select a network.

Foronereaderperdooronthe Access Control Panel, clickthe One

Reader per Dooricon L .

Fortworeaders perdooron Access Control Panel, click the Two

Reader per Dooricon " .

i

Note:

Make sure that Dip Switch 3 position on the panel corresponds with
it's position demonstrated on the panel properties window.
The Door Controller Panel Properties window opens.

Panel properties

General Options
Deseription Hardware version
[5vPanel | 1 =
e e 4Doars - 4 Readers
5 4 W Enabled

F
Input | Function Dutput Function
Input 1 Door 1 REX Dutput 1 Door 1 lack
Input 184 Door 1 Honiter Dulput 14 General puipase
Input 2 Door 2 REX Output 2 Door 2 lack
Input 24 Diaar 2 Moniter Dutput 24 General puipase
Input 5 Door 3REX Output 5 Door 3 lack
Input & Do 2 Moniter Dutput & General puipase
Input 7 Door 4 REX Output 7 Door 4 lack
Input 8 Diar 4 Moniter Output 8 General puipase
Test e tancel |

Figure 15: Door Controller Panel Properties window

The Door Controller Panel Properties window contains the following fields:

Field Description

Panel Enteran addressnumberforthe panel.

Address The network's addressis displayed to the left of the panel
address. Valid entries are 1-32.

Hardware Selectthe appropriate panelhardware type.

Version

Enabled Enable the checkboxto activate this panel.
Clearthe checkboxifthe panelis not connected.
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Field Description

Upload Enable the checkboxto send previouslogged eventsfrom

Previous the panel.

Events

Inputs Displays the input connections forthe panel.

Outputs Displays the output connections forthe panel.

Test Click to testthe panelis correctly connected to the
computer.
The Test Panel window displays hardware detailsincluding
hardware type, firmware and bootloaderversions, and
indicates whetheranl/0 expansion board isinstalled on the
panel.

3. Selectthe appropriate Hardware Version foryour panel.

Ensure thatthe DIP switch onthe panel matchesthe diagram at the
top of the screen.

Click OK.The window closes and the display area displaysthe new

Panel.

i

Note:

After a panelis connected, AxTrax AS-525 can also detect and
add it automatically. For more information, see Detecting Panels
Automatically, page 77.

Configuring the Panel

Each panel hasindividual settings for antipassback behavior and for
recording events.

Once

the panelis connected, configure a panel's options from the

Optionstabinthe Door Controller Panel Properties window.

i

When there is communication with the panelthe Tx and Rx LEDs
flash.

To configure a panel:

1.

In the

tree view, click on Networks.

The available networks are listed in the display area.

Expand a networkin the tree view and select a panelto configure.

=1

Click on the Editicon
The Door Controller Panel Properties appears.
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| Panel properties
General T {Optionsi
Door antipassback:
Automatic antipassback & Hard [alarm and access denied]
[1ever = falarm o]
IM Readers: OUT Readers:

™ 1\Panel 1 \Reades 1
[~ 1\Panel 1 \Reader 2
™ 1\Panel 1 \Reader 3
™ 1\Panel 1 \Reader 4

Events filter

% Select reported events.

Door Interlock
[ Enabled

[v Doorl [~ Door3
v Door 2 [~ Door 4
Test Ok ‘ Cancel |

Figure 16: Door Controller Panel Properties Options tab
The Optionstab contains the following fields:

Field Description

Automatic Selectthe time zone for door antipassbackrulesto apply.

Antipassback

Hard When hard antipassbackisselected, an eventis
generated and the doordoesnotopen.

Soft When soft antipassbackisselected, the door opens but
aneventis generated.

Reader 1-4 Enable the checkboxesto apply antipassback

restrictionsto Reader 1 thru Reader4 asrequired.

Only when the check-boxis checked isthe reader
Antipassback enabled.

Select Openthe Events Filter and select the Events this Panel
should record.

Setthe filter's operation method:

e Always Active- Only the selected events are
recorded by the panel.

e Active when disconnected-If the panelis
disconnected from the AxTrax server, only the
selected events are recorded. When the panelis
connected to the server, all event arerecorded.

Note:In default configuration, some events are filtered
and may not be seenin display area - events view.
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Field Description

Door Interlock Check the Enable checkboxto enable Doorlnterlock.
Checkthe Enable Door 1-4 checkboxes to apply the
Door Interlock restrictionsto Doors 1-4.

The DoorlInterlock functionis only enabled when the
Enable check boxes and a minimum oftwo Doors are
checked.

4 Note:
!"] The Door Antipasshback feature is now available forfour doors. To
"l activate Antipassback, check the INReader/ OUT Reader
check-box nextto the appropriate reader/s. Interlock(for Panels

with 2,4 Doors only) is preserved in orderto open anotherdoor
when the current doorisopen.

3. Click onthe Optionstab.
4. Set Antipassback and eventfiltering for this panel and click Test.
The testscreen displays the following information:

5% Panel 1 Hardware [

The Panel iz connected.

Firmware version: ac22501_04_30
Bootloader versian: btl_acZ2fw_01_02
Hardware: AC-225
Supervized [nputs: ez

MD-084: Maone

MD-D02 Yes

Figure 17: Panel Connection Test

Field Description

Firmware version The firmware version of the board.
Bootloader The bootloader version of the board.
version

Hardware The hardware name.

Supervised Inputs The panelissecure in case of tampering.

MD-1084 MD-1084 does or does not exist
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Field Description

MD-D02 MD-D02 does ordoes not exist

5. Click OK.
The window closes and the display area displaysthe new Panel.

!'m A panel configuration can be copied-and-pasted between

panels. Right-click on a panel and select Copy from the shortcut
menu then Right-click on a second panel and select Paste from
the shortcut menu. Properties can only be copied between
panels of the same door controllertype and hardware version.

5.4 Setting Door Properties

Every Panel controls one ortwo doors, orfour doorsif MD-D02reader
extension boardis connected. Each doorcan be configured individually.
The Door Controller Properties window displays the following:
e The settings for unlocking and re-locking
e Thetime available before the doorrelocks orrecords alarm
events

To set door properties:

1. Inthe tree view, click on Networks.
The available networks are listed in the display area.

2. Selectanetwork and expand a panelinthe tree view.
Select a doorto setits properties.

=
3. Click onthe Editicon
The Door Controller Properties Window opens.
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Description Auto relack

[1Fanel 1400or

O door moritor closed

v REX enabled
[ First person delay on automatic unlock
[™ Dioor output polarity is Marmally Closed

v Marual door open enabled

Timers

Droor open time W [mir: sec)
Extended door open time: ,m [mir: s2c)
Daar held open [ ]—7 {mir e
Dioor forced open |— ,7_ [min:sec)

Cancel |

Figure 18: Door Properties window

The DoorProperties window contains the following fields:

Field Description
Description Enter a name forthe door.
REX enabled A Requestto Exit unlocksthe doorfor a user-defined

duration. Enable the checkboxto allow Requests to Exit
forthis door.The doorREX inputslocationsdepends on
panel configurations, they can be seeninthe panel
properties window.

First person delay
on automatic
unlock

Setsthe door's behavior during an automatic unlock
time zone. Enable the checkboxtorequire that during
the selected Time Zone the doorremains unlocked only
after the first user opensit. The automatic unlock time
zone isselected in Panel Links Window by selecting the
output corresponding to that door. See Setting Panel
Links, page 53.

Door output
polarity is Normal
Closed

Enable this checkbox to ensure fail Safe door opening if
the Fail Safe doorLock Device powerfails. Once
enabled, the door outputrelay will activate when the
dooris closed and de-activate when doorisopen.In
this configuration, the Fail Safe lock device should be
wired to the doorrelay N.O (Normal Open) and COM
(Common) terminals.

Manual Door
Open Enabled

Enable thischeckboxto allow operatorsto adjust the
door manually. See Controlling the Door Manually,
page 70.
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Field Description

Dooropentime Setthe duration for whichthe doorstaysunlocked.

Extended door Setthe duration for which the doorstays unlocked for
opentime users with Extended door open rights.

Door held open Setthe duration for which the doorcan be held open
without raising an event.

Enable the checkboxto use thistimer.

Door Forced Setthe duration after which when the dooris forced an
Open event occurs.

Enable the checkboxto use thistimer.

4. Configure the door asrequired and click OK.

5.5 Configuring the Reader

A panelcanbe connected to tworeaders, orfourreaders when MD-D02
extension boardis connected.
Thereader properties window hastwo tabs:

The Generaltab sets general operation settings forthe reader
The Optionstab sets access options forthe reader

To configure a Reader:
1. Inthe tree view, click on Networks.
The available networks are listed in the display area.
2. Selectanetwork and expand a panelin the tree view.

Expand a door within the panel and select areaderto setits
properties.

o
Click on the Editicon d .
The ReaderProperties Window opens.

General Reader Operation Settings

The ReaderProperties Generaltab displays:

The settings for how the reader will operate
The type ofreaderthatis being used
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2%Panel 1\Reader 1 properties

General T Options
Details
Description Operation mode
2\Panal 1 \Readsr 1 |Card anly -l
(i @ In Secured (Card+PIN) time zone
‘Never ﬂ
" Out
Activation: [v Open Doar | Deduct User counter
Type
Readet type Keypad type
|W\egaﬂd 26 hits j ‘Nune ﬂ
HID Corporate 1000 P
Wiegand 32 bits
Wiegand 32 bits data reversed
Wiegand 34 bits
Wiegand 40 bits
Wiegand 40 bits PCSC
Wyiegand 64 bits
Clock snd Dt b-sicils oK ‘ _— ‘

Figure 19: Reader Properties General tab

The ReaderProperties Generaltab contains the following fields:

Field Description
Description Enterthe name ofthereader.
Operation Select how thereader operates.
Mode Inactive: The readeris notin use.
Card Only: Thereader will accept RFID cards only.
PIN Only: The reader will accept PIN inputs only.
Card orPIN: The reader willaccept both cards and PIN
codes.
Desktop: The readerisinactive, but being used to
record new cards onthe computer.
No Access Mode: Thereader will not grant accessto
any users.
Direction Select whetherinthereaderis allowing accessinto the area
or exit out ofit.
Secured Select atime zone during which accessshould be granted
(Card+PIN) only after both the card and PIN are entered.
time zone The PIN must be entered within 10 seconds of the card.
Open Door Enable the checkboxto allow thereaderto unlockthe door.

Deduct User

Enable the checkbox torecord this entry against the user's

Counter entry allowance counter.
See General User Properties, page 45.
Readertype Selectthe data transmissiontype forthereaderhardware.
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Field Description

Keypad type Selectthe data transmission type forthe type of keypad
hardware.

Check Enable the checkboxto allow accessto any user assigned

facility code to a facility listed in the selected list of facilities.

only The list of facilitiesis defined on the Options tab.
A_YC'W(?SOO Enable the checkboxto interface with the AYC-W6500
E':;?j‘;‘r"c hiometric reader and its PC application, BioTrax.

3. Configure thereader asrequired and click OK.

Reader Access Options

The ReaderProperties Optionstab displays:

Timed antipassback settings forthe reader
Restricted site accesssettings

Reader properties 3]

General T

Timed antipasshack:

Autornatic antipassback

|Ne\u’e[ j & Hard [alarm and access denied)
Tt ™ Sakt [alarm only)
£ ;
1 = [1 to 255 minutes]
Facility codes

Add from list
Add manually
Remove

oK ‘ Cancel

Figure 20: Reader Properties Options tab
The ReaderProperties window contains the following fields:

Field Description

Automatic Selectthe time zone in which timed antipassback rules

Antipassback apply.TosetTime Zones, see Defining Time Zones,
page 25.
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Field Description

Hard When hard antipassbackisselected, an eventis
generated and the doordoesnotopen.

Soft When soft antipassbackisselected, the dooropens but
aneventisgenerated.

Time Setthe number of minutes before a user canre-enter

using thisreader.

Add from List

Clickto add sites from a list.

The site list applies only when the Checksite code only
checkbox onthe Generaltabisenabled.

Add Manually Click to enter a site code.
The site list applies only when the Checksite code only
checkbox onthe Generaltabisenabled.

Remove Remove the selected site from the list.

4. Configure thereader asrequired and click OK.

5.6 Configuring the Inputs

Every panelhasfourinputs. Using MD-1084 adds another eightinputs (12
inputs total) and using MD-D02 adds fourinputs (8 inputs total). Some
inputs are dedicated and some are general purpose inputs. The panel
properties window displays the settings foreach input.

Inputtypeis programmed individually no matterifitis a dedicated input
orgeneral purpose input.

To configure an Input:
1. Inthe tree view, click on Networks.

The available networks are listed in the display area.

2. Selectanetwork and expand a panelinthe tree view.
SelectInputs and select aninputfrom the display area.

1

3. Click onthe Editicon
The Input Properties Window opens.
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1%Panel 6\ Input 1

Description
| 14Panel B\Doar REX

Type
|N0rma||_l,l Open j

Activity start delay
00:00 =~ [min:zec)

Cancel

Figure 21: Input Properties window
The Panel Properties window contains the following fields:

Field Description
Description Enter a name forthe input.
Type Selectthe type ofinputto be monitored.

Normally Open/Close: Aninput eitherin an open
or close state.
Normally Open/Close 1 Resistor: Aninputin an
open, close ortrouble state.

This optionis only available forsupervised inputs.

Normally Open/Close 2 Resistor: Aninputin an
open, close ortrouble state, with additional
checks forshort-circuit and open-circuit
tampering.

This optionis only available forsupervised inputs.

For more information, please referto the access control
panel hardware manual.

Activity start Setthe delay time before thisinput becomes active.

delay Note that on normally openinput, the delay starts once
the input contactis closed. On normally closed input,
the delay starts once the input contact opens.

4. Configure the input asrequired and click OK.

5.7 Creating Access Groups

An accessgroupis alist of doorreaders and of time zones during which
each ofthose doorreaders are available foraccess. Every useris assigned
to an access group.

The Access Group window lists allthe doorreaders defined in the
database and the time zones during which they can be accessed.

Page 39 AS-525 AxTrax Software Installation and User Guide



How to Set Up a Site

To create an access group:
1. Expand the Groups elementinthe tree view and select Access

Groups. Clickthe Newicon “ onthe toolbar.
The Access Groups window opens.

Access group E]

Description
|H&D Access Group
Reader [ Group time zone
8 H14Panel 1 \Readsr 1(n) [Newer |
B 1\Parel 1 \Reader 2[0ut) Might Shift
8 2\Panel 2 \Reader 3m) Might Shift
ﬂ 24Fanel 2 \Reader 4(ln) Mever
& Deskin) Office Hours
ﬂ ain Entrance-Entry(ln) Always
8 Main Entrance-Exitfln) Always
8 Marketting(ln) Mever
2 RD Enty(in) Always
H R&D Esitin) Always
ok Cancel

Figure 22: Access Group window
The Access Group window contains the following fields:

Field Description
Description Enter a name forthe access group.
Reader Lists everyreader defined inthe database.

Group time zone Selectthe time zone during which thisreadershould be
accessible.

2. Enteraname forthe access group and settime zonesforreaders as
required. Click OK.
The window closes and the display area displaysthe new access

group.

Accesssettingscan be copy-and-pasted between access
groups. Right-click on a access groups and select Copy from the
shortcut menu. Right-click on a second access group and select
Paste from the shortcut menu.
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5.8

Input groups are a collection of Inputs from panelor panelsthat can be

Creating Input Groups

used in panellinksto perform advanced operations.

To set an Input Group

1.

3.
4.

Input Group 3]

Gotothe Groupssectioninthe Tree View pane, and expand the

view.

Select"Input groups," and right click the selection to create a
new group

or

Press the "New"icon to create a new Input group.
Expand the network(s) and panels.
Finally, check allrelevant Inputs.

Description

|Input group 1

Input 1 - 14Panel 14Daor REX
Itput 14, - 15Panel 14Doaor Maritar
O lnput 2 - 14Fanel 145 pare Input 2
O Input 24, - 1%Panel 145 pare Input 24
= Metwark 2 2]
-1 24Panel 1
Input 1 - 24Panel 14Daor REX
Itput 14, - 2%Panel 14Doaor Maritar
O lnput 2 - 24Fanel 145 pare Input 2
O Input 24, - 24Panel 145 pare Input 24
[+ 24Panel 2
[l 24Panel 3

0K Cancel

Figure 23: Input Group Creation
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5.9 Creating Output Groups

Output groups are a collection of Outputsfrom panelorpanelsthat can
be usedin panellinksto perform advanced operations,such as Elevator

control.

To set an Qutput Group

1. Gotothe Groupssectioninthe Tree View pane, and expand this
view.

2. Select"Output groups,” and right click the selection to create a
new group
or
Pressthe "New"icon to create new Output group.

3. Expand the Network(s) and panels.

4. Finally, check allrelevant Outputs.

D ezcription

|Dut|:|ut group 1

(1]
=[] 14Panel 1
O Output 1 - 14Panel 14Doar lack
O Output 14 - 15Panel 140utput 14
O Output 2 - 15Panel 140utput 2
O Output 24, - 14Panel 140utput 24
=[] Metwork. 2 (2]
-] 24Panel 1
O Output 1 - 25Panel 14Door lock
Output 14 - 25Fanel 150utput 14
Dutput 2 - 25Panel 140utput 2
O Output 24 - 25Panel 140utput 24
+-[] 24Panel 2
+- ] 24Fanel 3

Ok Cancel

Figure 24: Output Group Creation
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5.10 Defining Cards

The AxTrax database maintains a list of every user card or PIN that has
been assigned.The Add Cards window defines:

The type ofreaderneeded toread the card
The number of cardsto create
If users should be created inthe database foreach new card

To Define Cards:

1. Select Cardsin the tree view.

Clickthe Newicon o onthe toolbar.
The Add Cards window opens.

Add Cards &

Manual [ MD-08

Readertype
|W\egand 26 bits j

Sequential cards
Cards quantity

[1
Start from(0 to 65.535)

Facility code (0to 255)

User Number started from

P

[ MewUsers

Cancel |

Figure 25: Add Cards- Manual tab
The Add Cards—Manualtab containsthe following fields:

Field Description

ReaderType Selectthe type ofreader appropriate forthese cards.

Cards quantity Enterthe number of cardsto add.

Start from Enterthe card numberforthe first card in the set.

Facility code Enterthe site code forthese cards.
This field is not available for allreadertypes.

New Users Enable this checkboxto create a new userin the
database foreach new card.
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Field Description

User Number Enterthe usernumberforthe first userin the set.

started from This field is only available when the New Users
checkboxis enabled.

A maximum of 1000 users can be generated at one
time.

2. Setfields asrequired and click Add.
A dialogreportsthatthe operation has been completed.

Enrolling cards using MD-08
This option is available for users with the MD-08 unit on-board.

To Define MD-08:
1. Select Cardsin the tree view.
Clickthe Newicon o onthe toolbar.
The Add Cards window opens (see Figure 25).

2. Clickthe MD-08 tab.
The MD-08 tab is displayed.

Ed Cards @
Manual | MD-08
Reader type Com Port
|'iegand 26 bits = =

| Facility Code | Card Mumber | Select all
Select none

[ Fivr Lisers Uszer Humber started from:

o

Add ‘ Cancel

Figure 26: Add Cards- MD-08 tab
3. SelectyourReadertype, and then Com Port.
1. Click Add.
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5.11 Defining Departments, Users and Visitors

Every useris grouped within a department. The AxTrax AS-525 stores
contact detailsfor each user, associated card details and useraccess
rig hts.
The User Properties window has four tabs:
Generaltab displaysidentification and controlinformation
Codestab displaysinformation about cards associated with the user
Detailstab records user contact details
User Fields tab stores user-defined data

To create departments:
1. Selectthe Departments\Users elementin the tree view.

2. Tocreate anew Department, clickthe Newicon “J onthe toolbar.
The Departments dialog appears.

Department

Description

Deparment 3

Ok Cancel

Figure 27: Department dialog
3. Enteraname forthe department and click OK.

To create users:

1. Expandthe Departments\Users element and select a Department for
the new user.

2. Clickthe Newicon . onthe toolbar.
The User Properties window opens.

General User Properties

The Generaltab displays:

Useridentification information
User validity settings
Accessrights forthe user
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User properties @

General T Codes r Details T Uszer fields
Phata
First name Middle name
I |
Last name User murmber
Diepartrnent Access group
| General | b aster ﬂ
“alid datedtime
Time getting not supparted in AC-215.
[~ Until
From
| 010342009 | | =
Add
1120 - =
Counter
Color
[~ Enahbled
Location v Set new counter u ﬂ i) i L)
Rightz Links
[ Antipazsback Immmunity [ Access Granted zommand Wsn o atizs) QUi RN
|None j
r E;E:ndecl docr open [~ Access Denied command [ Handicapped

_‘_"17_‘_‘ MNew User ‘

(0] ‘ Cancel ‘

Figure 28: User Properties Window

The Generaltab containsthe following fields:

Field Description

Add/Remove Clickto add a photo of the user, ortoremove
an existing photo. Note thatthe selected photo
aspectratio should be 1.25 Hx 1.00 L otherwise
the photo may be distorted.

First name Enterthe user's first name.

Middle name

Enterthe user's middle name.

Last name

Enterthe user'slastname.

User number

Enter a unique user numberto identify the user.

Department

Selectthe user's department.

Access group

Selectthe user's access group.
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Field Description

Select color Click to select which colorto use to highlight this
userwhen access eventsgenerated by that
user.
User highlighting must be activated in Tools >
Options> Generaltab.

Location Click to display alog of doors accessed by this

user.

Valid date/time from

Enterthe date/time from which the users access
rights begin.

Valid date/time until
(checkbox)

Enable the checkboxto setthe date/time on
which the user's accessrights end.

Valid date/time until
(field)

Enterthe date/time on which the user's access
rights end.

This field is only available when the checkbox
hasbeenenabled.

Enabled Enable the checkboxtosetan accessrights
countdown counterfor this user.
When the counterreacheszero, the user's
accessrights end.

Test Clickto checkthe current state of the user's

countdown counter.

Set new counter
(checkbox)

Enable the checkboxtoseta new countdown
countervalue forthis user.

Set new counter (field)

Entera new countdown countervalue for this
user.

This field is only enabled when the Setnew
countercheckbox hasbeen enabled.

Rights  Antipassback
immunity

Enable the checkboxto override any
antipassback restrictions for this user.

Extended door

Enable the checkboxto entitle this userto an

opentime extended unlocked door duration.
The extended durationissetforeach door. See
Setting Door Properties, page 33.
Links Access Enable the checkboxto activate a user-defined
Granted set ofinputs or outputs for this user.
command

The operations are setin the Links window. See
Setting Panel Links, page 53.
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Field Description
Access Enable the checkboxto activate a user-defined
Denied set of inputs or outputs for this user.
command The gperations are setin the Links window. See

Setting Panel Links, page 53.

User Select an output group for this user.
selected  The gutputs will be triggered every time the user
Output accesses a door, asspecified in the Links
group window. See Setting Panel Links, page 53.
Handicapp Enable the checkboxto activate a dedicated
ed check- outputashorttime afterthe dooris unlocked.
box

The outputs are setin the Links window. See
Setting Panel Links, page 53.

Associated Cards and Codes

The Codestab displays:

The card codes assigned to this user (up to 16 cards)

The PIN code assigned to this user

Biometric fingerprint templates for this user, only valid when using
Rosslare’s AYC-W6500 Biometric reader and its corresponding PC

application
General {Eodes 1 Detaik Il Use fiekds

Caids

[ SieCode | Card Number [ Status Add from st
=H 0000000010 Active

Add manually
Fiemove

PIN Code

Number of digits Code

4 > 1234 Auta PIN
Fingerprint

Fingerprints: 0
4| 4510 [ 3] New User | oK | Cancel

Figure 29: Users General tab

The Codestab containsthe following fields:

Field

Description

Site Code

The site code assigned to this card.
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Field Description

Card Number The unique number of this card.

Status Select the status of the card. Inactive cards cannot
gain accessto the facility.

Add from list Clickto add a new card.
All cards within the user'sspecified site code are listed.

Add Manually Click to create new cards from the Add Cards window.
For more information, see, page 43.

Number of digits Selectthe length of the PIN for this user.

Code Enter a PIN.
Auto PIN Clickto automatically generate arandom PIN.
Fingerprint Specifiesifthe userhasrecorded fingerprint templates.

For use with the AYC-W6500 Biometric Reader and its
corresponding PC application.

User Contact Details

The Detailstabrecords contact and identification details about the user.

Goneral I Codes T Details User felds
Telephons Home telephone
|718 63 256 7222 |718 34 567 3296
Mobile Car registralion
[ 073 363 3453 |23BD 2367
Fax Tille
[ [Prafessar
Email Employmert date
[iohnamith@noone co.not 0140402010 ~|
Address Notes
Flat 1 Keeps losing his cards|
st Street
Oneville
1111
Details
14| 4510 [ 3] Mew User | oK ‘ Cancel ‘

Figure 30: Details tab
The Detailstab contains the following fields:

Field Description
Telephone Enter an office telephone numberforthe user.
Mobile Entera cell phone numberforthe user.
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Field Description

Fax Enter a fax numberforthe user.
Email Enter an email address for the user.
Address Enter a postal address forthe user.

Home telephone Entera home telephone numberforthe user.

Carregistration  Enterthe user'slicense plate number.

Title Enter the user's title (e.g. "Mr.").

Employment Date Enterthe date the userjoined the firm.

Notes Enter any additionalinformation.
Details Clickto open the user's additional details folder.
User Defined Data

The User Fieldstab can be used to store anyinformationrequired by the
system operator.

General 1 Codes I Details | Userfields
User Defined
User Defined
User Defined
1 E
I iiser Defined
4] 4)7 Hew User | ok ‘ Cancel |

Figure 31: User Fields tab

Userfields are defined in Tools > Options > User Fields tab. See User
Defined Fields, page 85.
3. Enterdetails forthe user and click OK.

4. Click"New User" from within usertab to add new users.
5. The window closes and the display area displays the user.

To create visitors:

1. Expandthe Departments\Visitors element and select Visitorsto add
new visitors.
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2. Clickthe Newicon . onthe toolbar.
The Visitor Properties window opens.

!'m Forinformation on the Codes, Details, and User Fields tabs, please

referto the To Create Userssection above.

5.12 Creating Access Areas and Global Antipassback
Rules

Alarge site can be divided into severalsmaller and more manageable
access areas. Reportscan be produced individually foreach area.

In addition, global Antipassbackrules can be applied foreach access
area. When global Antipassbackrules are in force, a user cannotre-enter

anaccess area untilthey have leftit.
AxTrax AS-525is connected and monitoring the entire access

ﬁ
control system.

Use the Access Area window to add entry and exit doorreadersto and
from an area within the facility.

Global Antipassback functionality is only enforced when the

To create a new access area:

1. Expand Access Areainthe tree view and selectthe parent area
within which to add the new access area.

Clickthe Newicon d on the toolbar.
The Access Area window opens.
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Description
Building Ertiance
Enter to ares Readers list Exit from aiea
Hl 5\Panel 1 \Fieadsr 1 Bl 54Panel 2 \Readsr 1 l 5\Panel 1 \Reader 3
8 5\Panel 1 \Readsr 2 #l 5%Panel 2 \Readsr 2 8 5\Panel 1 \Reader 4
8 B\Panel 1 \Feader 1
8 B\Panel1 \Reader 2
8 B\Panel 2 \Feader 1
# B%\Panel 2 \Readsr 2
oK Cancel

Figure 32: Access Area window
The Access Area window containsthe following fields:

Field Description

Description Enter a description forthe access area.

Enterto area Liststhe entry readersinto thisaccess area.

Exit from area Lists the exitreaders out of thisaccess area.

</> Clickto add and remove readersfrom the Enter to

Area and Exit from Area lists.

2. Enteraname forthe access area and select entry and exitreaders.
Click OK.
The window closes and new access area appearsinthe display area.
3. Select Global Antipasshbackin the tree view and clickthe Newicon

onthe toolbar.
The Global Antipassback dialog appears.
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Global antipassback iz active only when Veritrax server is running and
connecting to panels.

Drescription
|Main Offices Antipassback

Access areas

| Main Office Area j
Automatic antipazzback
|foice Hours j

i Hard [alarm and access denied]

f* Saft [alarm anly]

(] 8 | Cancel

Figure 33: Global Antipassback dialog box

4. Enter a description forthe Antipassbackrule, selectthe access area
and time zone for which it applies. Select Hard or Soft Antipassback.

5. Click OK.

The dialog closes and the global Antipassbackrule isshown in the
display area.

I'm Global Antipassback will cause Antipassback event only on

"Enter"readersto the defined "Area".

Toimplement Antipassback on Exitreaders as well, itis necessary
to define a new area with opposite reader directions:

Readers defined "Enterin first area need to be defined againin
the new Area as"Exit"readers, and "Exit"readersin first "Area"
should be defined "Enter"readersinsecond "Area".

5.13 Setting Panel Links

PanelLinks are rules for how the system should behave when eventsoccur
inthe access control panel. The Links window displays:

Aneventon a panel andthe panel elementto which the link
response applies

The required input or outputresponse

Any alarm message to display on the AxTrax AS-525 computer

To create a panel link:

1. Inthe tree view, click on Networks.
The available networks are listed in the display area.

2. Selectanetwork and expand a panelinthe tree view.
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Select PanelLinks and select a link from the display area.

Click on the Editicon

Saurce Type

gt

Evan

ﬂ
The Links Window opens. -
i ]

[caract Gasea

¥ Ennslan

Adam handier

Dustnaion Type
o= B
Destnanon
g 1- 2\Fanal 1\Ocar REX [Mone 3
Dpeabion
Conlact Closed [Hens =]
Evenn Dasergion Time fmmss)
Time Zone
¥ Gengrate Absm |Adeierys T_‘
Adaum Massnga
Solnct colar
¥ Soand
Select Weve Audio file
ICAWRDOWS Mo dis’ ther wey
Sound now Erawnn
o | Cancel |

Figure 34: Links window

The Links window contains the following fields:

Field

Description

Source Type

Selectthe panelelementtype whichraisesthe event.

Source Selectthe panel element which raises the event.
Up to 8linkscan be added foreachsource in AC-225
and AC-525.
Up to 2links can be added foreach source in AC-215.
Event Selectthe event.

Event Description

Enter a description forthe event.

Enabled

Enable the checkboxto activate thislink rule.

Generate Alarm

Enable the checkboxto generate an alarm condition
when the selected event occurs.

Destination Type

Selectthe panelelementtype thatrespondsto the
event.

Destination

Selectthe panelelementthatrespondsto the event.

Operation

Selectthe operation forthe destination element to
perform.
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Field Description

Time Enterthe duration for which this operation should
apply. This boxis only available when a time-bound
operationisselected.

Time Zone Selectthe time zone during which thislink rule applies.

Alarm Message Entera message to be displayed as an on-screen
alarm when the selected event occurs.

This boxis only available when the Generate Alarm
checkboxhasbeenenabled.

Select Color Click to select a colorforthe alarm message.

This boxis only available when the Generate Alarm
checkbox hasbeenenabled.

Sound check-box Click to select Sound for Alarm; operable when
Generate Alarm check-boxis checked.

Browse Browse files forthe sound *.wav file you want forthe
Generated Alarm to sound.

Sound Now Click Sound Now buttonto generate the selected

button sound.

!'iﬂ Numerous events and links are defined in Panel Links. The

Operators must avoid conflicts orillogical definitions. Not all event
sourcesthat appearin Panellinks are enabled inthe panel, and
the Operatorshould verify them. Test the Link condition
operations after making any changesin the Link definitions.

5.14 Creating Elevator Control

Elevator control can be created in the following foursimple steps.

Step One:
Assign areaderto the elevator control.

Normally, areaderis associated with a door. For elevator control, a
selected readershould be associated with several outputs (floors). In the
readerProperties window, deselectthe Open Door check box. See
Setting Door Properties section on page 33.

Step Two:

Create output groups.

Every output group represents a floor orseveral floors. To create an
output group, see Creating Output Groups on page 42.
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I'm When creating an output group forthe elevator control, the

selection only appliesto outputs from the same panel.

Step Three:
Create panellink.

(Only one panellinkisrequired.)

Figure 35 shows the Panel Link confi%uration.

Source Typs Destination Type
|Reader -~ [User's Dutput Group ~|
Source Destination
|Reader 1 - 2\Panel 1 \Reader 1 ~| [User's Dutput Group |
Evert Operation
| Output Group selected by user ~| [ Output Timer |
Evert Description Time (romcss)
[Elevater contral [ o004
¥ Enabled Time Zone
r [ &luays |
-
Select Wave Audia fis
oK. Cancel

Figure 35: Panel Link Configuration

Step Four:

Associate users with elevator control rights.

Each usercan be associated with the relevant access group to allow that
user accessto specific floors, asneeded.

Inthe Generaltab of the User window, associate a user with output
groups.See General User Properties, on page 45.

5.15 Creating Status Maps

The Status Map displays the status of every door, input, output,
antipassbackrules and alarmsin the facility on user-selected floor plans.

To set-up a Status Map:
1. Inthe tree view, click on Events, then click Status Map and click on

the New Elementicon
Anew map element appearsinthe tree view.
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2.
3.

4.

Right-click onthe new map element. A shortcut menu appears.
Select the Picture option. The SelectImage File window opens.

!'m To change mapimage and/orto add objects on the map, you

must pressthe Pause key - (see Toolbar, page 19), after which
the option toright clickthe map name on the tree view will be
enabled.

Select a graphic file forthe Status Map background.

The file isshown in the display area in one of the following formats:
ipg, gif or bmp.

Axtrax AS 524 Access Control System

# [ Access aes
) Gl artipsssbunch
@ Cats

+ th Depatmants'Liseet

Figure 36: Status Map with Image
Ensure that the Status Map toolbaris showing the "offline mode"icon

| ]

Click on Networks and right-click on a door,reader, input, output,
paneloranotherstatus map thatshould be displayed as an object
on the status map.

Select Add to Map from the shortcut menu.

The object appearsonthe status map, and can be dragged to its
correct position.

Page 57 AS-525 AxTrax Software Installation and User Guide



How to Set Up a Site

42 Access Control System

nanuatrslin 00T [

Figure 37: Status Map with Door

6. Right-click on a map objectto setits properties, and select Show on
Map from the shortcut menu.

The Show on Map window opens.

Show on Map - 1'Panel 14 Door

Statuz

" By Door Maonitar

» By Door Output

(] 8 Cancel

Figure 38: Show on Map window

7. Enable the Status checkboxto display the objectsstate on the status
map.

Fora door'sShow on Map properties, select:
By Door Monitor- show the door's open state based on its physical

p osition.
By Door Output-show the door's open state based in the status of its
lock.

8. Repeatstep 5-7 until all objects are shown on the status map, as
required.

Repeatssteps 1-7 to setup additional status maps.
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!'|||] Status mapiconscan also be added to otherstatus maps,

indicating where the two map areas meet.

5.16 Setting Door Forced

DoorForced occurs when a controlled dooropensillegally when the door
relay outputis not activated. This may occurifsomeone opensa door
withoutinputting a valid code orusing a Door REX button.

In orderto detect a Door Forced condition, the door must be equipped
with a door contact connected to the Monitorto the MonitorInput of the
relevant door.

When DoorForcedis enabled, the system can generate a Door Forced
event, which can be used to generate an alarm orto toggle an output.

14Panel 2\Door 1 properties

Droor lock [Cutput 1}
Drescription Auto relock
|‘I\F’anel 24Doar 1 On doar monitor closed j

v REX enabled
[ First person delay on automatic unlock
™ Door output polarity is Mormallp Closed

¥ Manual door open enabled

Timers
Door open time 0:04 <=~ [minsec)
Extended door open time 0:08 == [mir:zec]
Door held open W 030 = [mirczec)
Door forced open W 000 = [mir:gec)
ok | Cancel

Figure 39: Door Properties

To Set Door Forced

1) Onthe AxTraxTree menu, select Network>Panel>Door.
The Door Properties window opens.

2) Checkthe DoorForced checkbox.

3) Entera delay (ifrequired) in Minutes and Seconds. Usually, delays
are norrequired since Door Forced is detected immediately.
This setting allows a "Door Forced" eventto be generated. The
event canthen be used to generate a system alarm, orto
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activate an output. All of these possibilities may be configured in
the "Links" window.
4) Onthe AxTraxTree menu, select Network>Panel>Panellinks>
"New" command button.
The Links window opens, followed by the Door Properties window.
5) Define the location and results of the Door Forced conditions:
In"Source Type" and "Source"selectthe Door on which Door
Forced should occur.

In"Event"select"Door Forced Open".

In"Destination" and "Destination Type,"selectthe operation that
DoorForced should trigger (including "None"if applicable).

6) To generate an alarm condition, enable the "Alarm" checkbox
and define the alarm details as described above.

Source Type Destination Type
‘DDOI ﬂ |Uulpuls j
Source Destination
[Door 1 - 14Panel 21D0or 1 ~| [Quput 14 - 14Panel 210utput 14 ~|
Event Operation
‘DDOI 1 forced open ﬂ |Dulpul Timer j
Ewvent Description Time [mn:ss]
[Daor 1 tarced open |EI[I 10 i
¥ Enabled Time Zone
v Generate Alam |Always j
Alaim handler

Alarm Message

Door Foroed Condiion B el

W Sound
Select Wave Audio file
‘E:\WIND OwStMedialingout. way

Sound now Browse

oK ‘ Cancel |

Figure 40: Door Forced Settings
5.17 Setting Door Held Open

DoorHeld Openisa condition where the controlled doorremainsopen
longerthan a predefined period. Thisis useful for detecting a condition in
which a dooris not closed condition afterit has been validly opened. The
DoorHeld Open condition may occurifsomeone blocksthe doorforfree
passage.

Inorderto detectthe DoorForced condition, the door must be equipped
with a Door contact, connected to the Monitorinput of the relevant door.
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When DoorHeld Openisenabled, the system can generate a Door Held
Open event, which can generate an alarm orcantoggle some output.

1% Panel 2\ Door 1 properties

Dioar lock [Dutput 1}

Description Auto relock,
|1 “Panel 24Door 1 On doar manitor cloged j

Jv REX enabled
[ First perzon delay on automatic unlock
[ Door output polarity is Normally Closed

¥ Manual door open enabled

Tirners
Daar open time 0:04 <=~ [min:zec]
Extended door open time 0:08 = [minsec)
Door held open v 0:30 = [min:sec)
Daar forced open v 0:00 == [min:sec)

ok | Cancel

Figure 41: Door Properties

To Set Door Held Open

1)

7)

Onthe AxTraxTree menu, select Network>Panel>Door.

The DoorProperties window opens.

Enable the "DoorHeld Open" checkbox.

Enterthe required delay in Minutes and Seconds. (Normally, 30
secondsis a sufficient delay.

This setting generates a "DoorHeld Open" event, which can be
used to generate a system alarm, orto activate an output.

These possibilities can be configured in the "Links" wind ow.

Onthe AxTraxTree menu, select Network>Panel>Panellinks>
"New"command button.

The Links window opens, followed by the Door Properties window.
Define the location and results of the Door Held Open conditions:
In"Source Type" and "Source"selectthe Door on which Door Held
Openoccurs.

In"Event"select"DoorHeld Open".

In "Destination" and "Destination Type"select the operation that
DoorHeld Open willtrigger (including "None"if applicable.

To generate an alarm condition, enable the "Alarm" checkbox
and define the alarm details as described above.
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Source Type Destination Typs

[Door ~| | Sounders |
Souce Destination

[Door2-14Panel 21D 00r 2 ~| [ crime -]
Event Operation

|Door 2 held open | | Sounder on =]
Event Description Time (mm:ss]

[Door 2 held open [ =

[ Enablsd Trez

W Generate Alam | always =]

Alarmn handler

Hlarm Message
Door Held Open. Make sure to closs the door. Default color

¥ Sound

Select Wave Audio file
‘E W INDD'WS WM ediabding wav

Sound now 7 Browse..
oK Cancel
Figure 42: Door Held Open Settings

5.18 Door Interlock

Doorlinterlock, sometimesreferred as Mantrap, preventstwo or more
related doorsfrom opening atthe same time. It may be useful forthe
entry holes of Clean Rooms orin other facilities with two exit doors. It
should only be possible to open one door at a time with a valid user code.

Axtrax features a dedicated mechanism to define Interlock for 2, 3, or 4
doors, aslong asthey are located onthe same access control panel.
Interlock cannot be used in panelsthatsupport a single door.

To enable Interlock, related doors must be equipped with a door position
sensor, connected to the Door Monitorinput of the relevant doors. Door
Interlock only restricts user entry throughreaders orkeypads. The use of
REX button orLinks settings should not be used to activate doors, which
are notlimited by Interlock.

Doors are considered open when eitherthe Door Monitor orthe Door
Relay are opened, and it should not be possible to open any other
related door with usercodes. If an attemptis made to open anotherdoor,
an"Access denied-Doorinterlock" eventis generated.
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Setting Door Interlock

In a typicallnterlock application with a 2Doors/4Reader panel controlling
entry and exitto a restricted area, the doors and readers may be located
as follows:

Door1/Readeri - Entry from outside into Man Trap room
Door1/Reader2 —Exit from Man Trap room to outside
Door2/Reader3 - Entry from Man Trap room into restricted area
Door2/Readerd — Exit from restricted area into Man Trap room

Restricted area

Entry and Exit Room room

Reader1l| Reader3 I

Reader2
/‘| i / IReader4

Door2

Door1

Figure 43: Door Interlock Diagram
Axtrax DoorlInterlock Setting:

1) Edit"Panelscreen >> Optionstab".
2) In"DoorlInterlock"select"Enabled" checkbox.
3) Enable atleasttwo doorcheckboxes.

futomatic wripasiback % Hard s and acean deeied]
‘o e ori)
Rifleader T Ao

W Doarl W Domd

7 DeasZ 7 Doad

Figure 44: Setting Door Interlock
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6. ViTrax Video Integration

Utilizing camera’s on your AC-525 panelis done using the following Steps:

Step Action Section

‘ Connecting to ViTrax Server. See Connecting to ViTrax
Server, page 64.

° Adding a Camerato AC-525 Adding a Camera to AC-525

panel. panel, page 64.
o Using Panel Links. See Setting PanelLinks, page
53.
° Viewing Recorded Events. See Viewing Recorded
events, page 67.

6.1 Connecting to ViTrax Server

Define the ViTrax Server database with which the AS-525 AxTrax Software
communicates.

To Connectto ViTrax Server:

1. When the ViTrax Serverisrunning, click File/ViTrax Server.
The ViTrax Servers window is displayed.

New —T.¢ T ]

Mess | User Mame ‘ Auto connect | Status |
Edit
Delete

Figure 45: ViTrax Servers

2. Clickthe Newicon d onthe toolbar.
The Server ViTrax window is displayed
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Server ¥iTrax disconnected =)

WiTrax IP Adress
‘Iocalhost

WiTraw User Name
‘admin

Wil raw Passward

‘ Connect

v Auto connect on Start 0K |

Cancel

Figure 46: Server ViTrax window

3. Inthe ViTraxIP Address field, type in either Local host or otherIP
addressname.

4. Inthe ViTrax User Name, type in Username

5. Inthe ViTrax Password, type in Password

i

The Password typed mustresemble the non-default password for
the server.
6. Click Auto connect on Start checkbox.

7. Click Connect.

8. Click OK.
The message “ViTrax Server Connected” is displayed.

The ViTrax servernow appearsin the ViTrax Servers window list
(see Figure 45).

¥iTrax Servers (3]
a @ =
P Acress [ User Name [ Auto cornect [ Status [
localhost admir Yes Connected

Figure 47: ViTrax Server list
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6.2 Adding a Camera to AC-525 panel

Defining communication of AC-525 camerasto the ViTrax Server,isdone
physically between the camera and the AC-525 panel, see AC-525

Installation Manual.
The cameras available on thisnetwork are displayed when clicking the

Network on the tree. When clicking the icon the camera listis displayed.
Expand the tree to see which cameras are connected to which panels.

To configure a camera to the network:

Configure the Network asseenin Section 5.2.
Once the camerais physically installed, the system readsthe camera

onthe network and displaysit on the tree.

AxTrax AS-515 Access Control System

= IRl e
Bharannye
o Al
B Frport

Figure 48: Camera icon

To view the camera list:

Clickthe Cameraicon.
The Camera list window is displayed.

| Descripacn | 1P Addrass | Ehanat | i Servar

arhzE /192 16810178 A localhost

Figure 49: Camera icon
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6.3 Conditioned Recording via Panel Links

You canselectthe source, destination, and period of recordings
using Conditioned Recording sequences, programmed via the Panel
Links screen.

To create a panel link:

1. Inthe tree view, click on Networks.
The available networks are listed in the display area.

2. Selectanetwork and expand a panelinthe tree view.
Select PanelLinks and select a link from the display area.

il
Click on the Editicon o .
The Links Window opens.

Source Type Destnation Typs
g <] [Lacairaearaing -
Source Destnation
[t 1 - 2\Panel 11Daar FEX =l [Carnern A mamentony recording B
Evont Oporaticn
[CormactCiased T R - |
Event Dieseription Tirre (min.ss)
[Cantect Closed |
[+ Ensbled Time Zane

I
[~ Genama Alnrm |y =]

o (==
Selact Wive Audio e
ak Cancal |

Figure 50: Local Recording
3. In Destination Type drop-down list, select Local recording.
4. In Destination drop-down list, select a camera: momentarily recording
or pre eventrecording, and then click OK.

6.4 Viewing Recorded events

Inthe Camera Properties window you can view live streaming and edit
various camera properties.

To access Camera Properties:
1. Double-click Camera <name>in the Tree View.
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= Al AxTrax AS-525
W Events

=24 Netwarks

-2 Metwork 1 (1)
-4 Netwark 2 (2)

= 1] 2\Panel
11 Panel Links
=+ 24yPanel 14Door
B Outputs
A Inputs
[ 2\Panel 1\Camera Aacs2s |

Figure 51: Camera Properties

2. Double-click Camera <name>inthe Tree View.
The Camera Properties window is displayed.

Camera Properies 53]

Dessiiption

[24Fanel 1\Camera & o525
Properties
PC Archive
Local rchive
Audio from Camera =
¥ Erabled
Yolume: 1
‘‘‘‘‘‘‘‘‘‘ )
0 sz
Audio to Camera
¥ Enabled
Miciophone Device
| SoundM&X Digital udio
Status: Connected oK Cancel
Figure 52: Camera Properties window
The Camera Properties window includes the following:
Field Description
Properties Camera hardware properties
PC Archive Streamssavedin PC
Local Archive Streamssaved in USB-key
Audio from Enable the option and select volume
Camera -
Audio to Enable the option and select Microphone Device
Camera-
3. Click OK.

i

ViTrax Server must be running to view recordings.
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For more information on camera properties, see Vilrax Software Manual.

To access Live Video:
1. Right-click Camera <name>inthe Tree View.

=824 Networks
- 25 Netwark 1 (1)
=33 Netwark 2 (2)
S 8] 24Panel 1
11 Panel Links

E 2\Panel 14Doar
£ Outputs
C] Inputs

Delete

Figure 53: View Live Camera

2. Inthe Right-click menu, select View.
The Live Video Streaming window is displayed.

Live ¥ideo - 1Panel 1',Camera B AC-525 [B] {192.168.20.159)

LA Status: Connected

[udio to Cameral

Figure 54: Live Video Streaming

The Live Video Streaming window includes the following:

Icon Name Description
.! Recording Saving streamsto archive, page 19.
.i Stop Stops Recording to the archive.

-:EH! Audio to Camera Speakfrom PC microphone by calling to
T Panel Ram

3. Click Cancelto close.
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7. Manual Operation

In addition to the AxTrax AS-525's automated monitoring and control of
the access control network, itis also possible to control the network
directly.

7.1 Controlling the Door Manually

The Door Manual Operation window allows an operatorto open or close
a selected group of doors directly.

To manually open or close a door:

m onthe toolbar.
The Door Manual Operation window opens.

1. Clickthe Open Door Manually icon

Door manual operation
1. Select the door operation by the option buttons.
2. Check the door for manual operation,
3. Click *Apply’ to sent the operation
Olptions
" Open momentarily [closed by timer) 0:04 =~ [min:sec]
" Open permanently [closed by ‘Close output and retum to default mode']

" Close output and return ta default mode

| Location Deseiption Status A Select sl
Netwark 2424Panel 1 24Panel 1\Doar Clase
Network 1414Panel 6 T4Panel 6Door 1 Close
Select nong
Network 1514Panel & 14Panel B\Door 2 Close
Netwark 1414Panel § 14Panel 5\Dioar Clase
Metwork 1414Panel 4 T4Panel 4Door 1 Close
Network 1414Panel 4 14Panel 4.Door 2 Close v
b2
ey | Carcel |

Figure 55: Door Manual Operation window

The operator can sort the listed panels/doorsinregularorreverse
order by clicking the column header with the left mouse button.

2. Selectan option:

Open momentarily- Allselected doors are opened forthe time setin
the timer box.
Open permanently- Allselected doors are opened.
Close output- Close the selected doors and return control to the
AxTrax AS-525.

3. Enable the checkboxesto selectto which doorsthe operation
applies.
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Click Apply to perform the operation.

===w| Note:

I || Door Manual Operation can only control doors that have been set
as Manual Door Open Enabled in the DoorProperties window. See
Setting Door Properties, page 33.

7.2 Changing the Reader Mode

The Manual Reader Operations window allows an operatorto change the
operation mode of areader.
Readers have six possible operation modes:

Inactive: The readeris notin use.

Card Only: Thereader will accept cards only.

PIN Only: Thereader willaccept PIN inputs only.

Card orPIN: The reader will accept both cards and PINs.
Desktop: The readerisinactive, but canrecord new cards for the
AxTrax AS-525 database.

No Access Mode: The reader will not grant accessto users.

Card + PIN: The readerrequires both a card and then a PIN. The PIN
must be entered within 10 seconds of the card.

To manually change the reader mode:

1. Expand the Networks element on the tree view and expand a
selected network.

Select a panelinthe tree view and clickthe Change Reader Mode
icon o .

The ManualReader Operations window opens.

Manual Reader operations
Options
" Change operation mode
* Detault
| Description ‘
TPanel 14Reader 1 = -
T\Panel 1 “Reader 2 Celect none
T\Panel 1 %Reader 3
T\Panel 1 \Reader 4
Lpply ‘ Cancel |

Figure 56: Manual Reader Operations Window
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Select an option:

Change operation mode permanently- Resets allselected readers to
the selected operation mode.

Change operation mode until Card+PIN starts- Resets all selected
readersto the selected operation mode untilthey enter a secured
time zone.

Inthe secured time zone, the operation mode switchesto Card +
PIN.

Default- Returns control of the readers to the system.

Enable the checkboxesto selectto whichreadersthe operation
applies.

Click Apply to perform the operation.
A

7.3 Controlling Outputs Manually

For more information on secured (Card + PIN) time zones, see
GeneralReader Operation Settings, page 35.

The Manual Output Operation window allows an operatorto open or
close a selected group of outputs on a panel directly.

To manually open or close an output:

Expand the Networks element on the tree view and expand a
selected network.

Select a panelinthe tree view, and then click the

E

Manual Dutput operation

Change Output Operationicon

Optiohs

& Open momentarily [closed by timer] 0:04 == [minsec)

" Open permanently [closed by Close output and return to default made']

™ Cloze output and retun to default mode

| D esciiption |
Output 1-1%Panel 24Doar 1
Output 14-1\Panel 250utput 14

Output 2-14Panel 24D oor 2 Select none

Output 28-1\Panel 2\0utput 24,

[alajala|

Apply | Cancel |

Figure 57: Manual Output Operation window
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2. Selectan option:

Open momentarily- Opens all selected outputs forthe time setin the
timer box.
Open permanently- Opens allselected outputs.
Close output and return to default mode- Closes the selected outputs
and returns control to the AxTrax AS-525.

3. Enable the checkboxesto selectto which outputsthe operation
applies.

4. Click Apply to perform the operation.
7.4 Manually Disarming Inputs

The Manuallnput Operation window allows an operatorto disarm a
selected group ofinputson a panel directly.

Armed input meansinputis active; Disarmed inputisinactive and will not
trigger any operation or alarms.

To manually disarm orre-arm an input:

1. Expandthe Networks element on the tree view and expand a
selected network. Select a panelinthe tree view and click the

:j .

Change Input Operationicon

Manual Input operation @
Options

" Input permanently dizarmed

& Am input and return to default mode:

| Desciption | i Selectall |

Input 1 - 15Panel 25Doar 1 RE=y
Input 14-14Panel 25Doar 1 Monitor

Select none
Input 2-1%FPanel 24D oor 2 REX

Input 28-14Panel 24Doar 2 Monitar

BEERE

Apply ‘ Cancel |

Figure 58: Manual Input Operation window
2. Selectan option:

Input permanently disarmed- Deactivates all selected inputs.
Arm input and return to default mode- Reactivatesthe selected
inputs and returns control to the AxTrax AS-525.
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3. Enable the checkboxesto selectto whichinputsthe operation
applies.

Click Apply to perform the operation.
7.5 Testing the Siren

The Manual Siren Operation window allows an operatorto testthe siren for
aselected panel.

To test the siren:

1. Expandthe Networks element on the tree view and expand a
selected network.

Select a panelinthe tree view, and then click the Siren Operation
icons.

Manual Siren operations @

Options

f+ Open momentarily [clozed by timerf 0:04 = [minzec)

" Cloze siren and returm bo default mode

Apply Cancel

Figure 59: Manual Siren Operations window
Select an option:

Open momentarily- Sounds the siren for the time setin the timer box.

Close siren and return to default mode- Silences the siren and returns
control to the AxTrax AS-525.

Click Apply to perform the operation.
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The AxTrax AS-525 supportstwo types of report.

Immediate reports list details of recent movements (within the last few
hours). They are shown in the display area and can be exported.
Archive reports are immediately exported.

8.1 Immediate Reports

There are fourtypes ofimmediate report:

Who's been intoday- Lists where and at whattime each user was
granted accessforthe first time today.

Last known Position- Lists where and at whattime today each user
was mostrecently granted access.

Roll-Call Readers- Lists the last time eachreaderwas accessed, and
by whom, within the last 1-99 hours.

Roll-Call Areas- Lists all users currently within the selected area, sorted
by department and entry time. The report lists all personnel who
entered the facility within the last 1-99 hours.

Toshow animmediate report, selectit from the Reports element of the
tree-view, underIimmediate.

To create a new immediate report:

1.

3.

Expand the Reports element and selectImmediate from the tree
view.

Clickthe Newicon d onthe toolbar.
The Immediate Reports Wizard opens.

Step 1 - Report type

~ The report wizard will help you create a new report,
‘fou can press back. at any time to change your selections.

What repor do you wish to praduce?
|Foll Call- Feaders -

Cancel | | Nest> | |

Figure 60: Immediate Reports Wizard (Step 1)
Selectareporttype and click Next.
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Follow the on-screen wizard instructions until the wizard has
completed. The display area liststhe new report.

8.2 Archive Reports

There are three ways of producing archive reports.

Panels events reports

Panel eventreports displays details of allrecorded panel events.
There are 5 available panel eventreports.

Attendance report - Lists the attendance hours forselected users,
sorted by date. Resultsinclude hours present, time in and time out.
Panelsreport - Lists all the eventsrecorded by the selected panels,
sorted by date.

Accessreport - Lists all access eventsrecorded by the selected
readers, sorted byreaderand date.

Areas report - Lists all users within selected access areas, sorted by
department and date.

Readersreport - Lists all users who have accessed the selected
readers, sorted by department and date.

Visitor report — Lists visitors who have made a visit to a certain user or
department, orlists allrelated visitors.

System AxTrax events report

System AxTrax eventreportslist details of system and operator activity.
There are 3 available panel eventreports.

System report - Lists all operations performed by the AxTrax server,
sorted by date.

Operatorsreport - Lists all the operations performed by registered
system operators, sorted by operation eventtype and date.
Alarms report - Lists all raised system alarms, sorted by operator and
date.

Interactive report

Interactive reports list details of users and their access activity.

User details - Lists selected users' details, including assigned cards, PIN
and assigned access group.

Users access rights - Lists site access details forselected users, with full
details ofreaders accessed and in which time zones.

Not responding users - Lists users for whom there have been no
access eventsfora selected period of time.
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9. Administrator Operations

9.1 Setting the Time and Date

Select panels by network and reset their date and time to the AxTrax
server'ssystem date and time, using the SetTime window.

To reset the panel time:
1. Expandthe Networks element on the tree view and select a network.

2. Clickthe SetTimeicon ‘j"l.
The SetTime window opens.

Set time
1. Check the panels for fime sefting.
2. Set the spstem time.
3. Click Apply’ 1o sent the new time.
Date 1140342007 Time: =i
[ Description Stalus [ Date [ I Select al
O  1WPanell Nat respanding - -
O 1'Panel2 Not responding F—
O 1Panel3 Nat responding
O 1'Paneld Not responding

‘ Cancel

Figure 61: Set Time window
3. Selectthe panelstoreset and clickthe Apply button.
The server connectsto the panels and setsthe time asrequested.
A dialog confirmsthe operation.

9.2 Detecting Panels Automatically

Itis possible to search for panels overthe access control network. This is
useful during installations; the AxTrax AS-525 finds all connected panelsin
the network and checksthem.Panelscanthen be quickly activated and
updated.

To detect panels:
1. Expand the Networks element on the tree view and select a network.
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2.

Click the Find Panelsicon %’ .
The Find Panels window opens.

Find panels

1. Click 'Test o detect all panels on the network
2 Select the new paneks for adding and downloading data by clicking on the checkboxes.
3. Click pply’to dowrload

| Descripti... | Panels status | Metwork status
i

a [ ]
m] [ ]

i

< >

Please wait

Figure 62: Find Panels window
Selectthe panelsthatshould be activated.
Clickthe Apply button to activate the panels and download setup
information.

Once the detection processis complete (may take 2-3 minutes), the
display shows all of the detected panels and their corresponding
information.

Selected panels willthen be automatically appended in the Tree
View under current network.

9.3 Manual Download of Panel Data

Operators can manually download specific access-control panel
configurations using the Download Data window. All of the panel’sdata
will be downloaded with no data parsing or filtering.

To manually download panel data:

1.

Expand the Networks element on the tree view and expand a
selected network.

Select a panelinthe tree view and click the Download Dataicon
L]
|

The Download Data window opens.
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1022"Panel 1 Download data =
Data | Statug |

Find firmware and clear old data
Dowrload Panel configuration
Events filter

Panel links

Olutput Groups

Input Groups

Time Zones

Holidays

Global &ntipasshack.

Users

Cards

Mote: Re-initialize: user's counters ocoure.

] Cancel

Figure 63: Download Data window

3. Clickthe Apply button to apply the operations.
9.4 Downloading Failed Data

Inthe eventthatsome data failed to download into the access control
panels,itis possible to perform a download of the failed operations only.
This operation can be done on a single panel, on allthe panelsin a

network oron allthe panelsin the entire system.

To download failed data:

1. Inthe Tree View, select a specific panel, a specific Network orthe

entire Networks.

N
2. Select and clickthe Download Failed Data icon 4 .
The Download Dataicon window opens.

Download data
e st sl hemrikocsd
dewrinad

| | Dseripton Panel Daraype Staha
O 240672007 45 0000023450 Maredl  Cad

o AGS0T &5 (O0ETss NPl 1 Cand

O 052007 45 000002M60 DPwadl  Cwd

O 24052007 45 000002ME! DParedl  Cad

o AGS0T &5 (O0ETME? NPl 1 Cand

O  MA05007 DPaeld'Aesde] DPawll  FResdsr

O 2480 Tem 2Pl Uner

o et PPl 2 User

O s DPweld U

O aevsz0 PPoredd  User

o ) ITH Tom PP User

O 062007 1. 0000000105 PPaw2  Cad

O 240572007 &5 00000256 Hared?  Cad

a AGS0T &5 (OOETuET NPl 2 Cand

O #05/2007 4500000258  DPweli  Cad

mn WNESNT BE OURS Al Y Faed

< »

Select |

el e |

Enabidn -.rhtﬂ!|

Daable

stlacted

Cancel

Figure 64: Download Data icon window
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3. Selecttherequired parametersto download by checking the
checkboxnextto each parameter,you can use to the Select All and
Select none for fast selection.

Click the Enable Selected or Disable Selected button to apply the
status to the selected parameters.

9.5 Testing User Counters

When using User Counters, Itis possible to view current User count value in
each panelthat hasReader designated with "Deduct User" option.

To view User Counters:
1. Inthe Tree View, select Department\Users then select one Userin

Display area.
, oo il
2. Selectand clickthe User Countericon ,the Request User Count
window opens.
Counter status Counter value
Enabled 3
24Panel 1 Enabled 10
2\Panel 2 Enabled 10
24Panel 3 Enabled 8
24Panel & Enabled 10
Test Cancel

Figure 65: Request User Count window
3. Clickthe Test buttontoread a User Counterin each of the panels.

9.6 Maintaining the Database

The system database is maintained from the Database window.

===w| Note:
This optionis only available within the AxTrax Server system.
|

To openthe Database window, select Tools > Database from the menu
bar.
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Database 5]

Paiiadic backup to camputer's lon' local diectories

Backup folder

IC:%Program Files\Rossl.

Fj Days

Browse..
Perform backup every * Perform backup ot
oo =
=0 means ro backup
Kate: The selected file name wil be sppended with _Veritiay_ve
Cancel

5.bak

irax &5 -22548 ackupiWeril

Figure 66: Database window

The following database operations are available:

Operation

Description

Periodic Backup

Run ascheduled backup every specified number of
days atthe specified time.

Backup now

Run a one-time backup immediately.

Export
Configurations and
Events

Copythe contents of the database to the selected
folder.

Import
Configurations

Replace the current configuration based on the
imported file.

Import
Configurations and
Events

Replace the current configuration and events
based onthe imported file.

Erase Configuration
and Events

Erase the current database configuration and all
events.

Import earlier
database versions
from

AS-215

Replace the current database.

Only VeriTrax AS-215 databases from versions 0.5—
2.02.04 and 2.05.00-2.05.05 ornewercan be
migrated.

Import earlier
database versions
from VeriTrax AS-225
/ AxTrax AS-525

Replace the current database.

VeriTrax AS-225 or AxTrax AS-525 databases from
versions 0.00.04 ornewer can be migrated. Note
that this option does not allow importing a database
from a current AxTrax AS-525 version.
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Operation Description

Limit panel Events Automatically erase events when they are older
period than a specified number of days.

Before using this option, Rosslare recommends that
you set a periodic backup.

Erase panel Events Erase all eventsthat are olderthan a specified
number of days.

==ww| Note:

The Backup and Export functions, add the “_VeriTrax_vX” prefix at
the end of exported or backed-up database.The Import
database function will execute only with the string atthe end of
the file name.

After a database has beenimported, the panelstatus may
change to disabled. If thisis the case, the operatorshould re-
enable the panels.

9.7 AxTrax Options and Preferences

The AxTrax AS-525 can be customized to meetthe preferences of the
operator using the Options window.

To openthe Options window, selectTools > O ptions from the menu bar.
The Options window has fourtabs:

Generalstartup, presentation and connection preferences
Settings to control AxTrax information pop-ups

Additional user-defined fields for the User Properties window
Report title settings

Startup, Presentation and Connection Options

The Generaltabincludes basic control over AxTrax AS-525 start-up and
security options, user highlighting preferences and transaction connection
settings.
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General T Pop up T User Fields T Report title
Default setting Language HASF key
™ Auto startup English - I™ Share data base with Veritire
Helidays Spstem events
™ Dutlook I~ Show download succeed
Highlight
¥ Use highlight user events ¥ Use highlight alarm events
[ Selected

v Al users

W Unknown key Default colar

Use highlight Networks and Panel status

user [~ Selected alams
Default color W &l alarms Dretault color

Rz e Defaut oolor ot resporiding Defauit color
Transmit ransactions
r Cam port Speed

Ok ‘ Cancel ‘

Figure 67: General tab

The Generaltab containsthe following fields:

Field

Description

Auto startup

Enable the checkboxto start the AxTrax AS-525
automatically when the computeristurned on.

Language

Selectthe system interface language. This option will
temporarily switch language untilyou close AxTrax AS-
525. Permanentlanguage settings are set under
Operators options.

HASP Key

Enable this checkboxif the system consists of lessthan
64 panels and you require the operation of the installed
VeriTime attendance software. Thisis possible by
checking if VeriTime optionisselected in the HASP key.

Outlook

Enable the checkboxtoload Microsoft Outlook™
holidaysinto the AxTrax AS-525.

Select Holiday

Click the button to select Microsoft Outlook™ holidays
toload into the AxTrax AS-525.

This buttonis only available when the Outlook
checkboxhasbeenenabled.

Show download
succeed

Enable the checkboxto add a message to event
history upon successful system parameters download
from the AxTrax AS-525 software to the panel.
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Field

Description

Use highlight user
events

Enable the checkboxto display selected user
informationin a colored highlight.

Selected user /
All users

Enable one ofthe checkboxesto highlight either
selected users or all users.

When Selected Usersis enabled, users are highlighted
when they have been marked for highlighting in the
User Properties window.

See General User Properties, page 45.

Unknown key

Enable this checkboxto highlight every record of
attempted access by an unknown card or PIN.

Use highlight
alarm events

Enable the checkboxto highlightselected alarm
events.

Selected alarms /
All alarms

Enable one ofthe checkboxesto highlight either
selected or all alarms.

Alarms are selected if they have been marked for
highlighting in Panel Links window.

If All Alarmsis enabled, all alarms are highlighted.
See Setting Panel Links, page 53.

Use highlight
Network and

This option can be used to quickly identify panelsthat
are notresponding or networks, whichinclude panels

Panels that are notresponding.
When selecting the root "Networks" tree view, Networks
with panelsthat are notresponding are highlighted
with the selected color on display area.
When selecting a specific Network on tree view, panels
that are notresponding will be highlighted with the
selected coloron display area.
Panelsthat are currently disabled are not considered
as"notresponding".

Select color Click to select a color for highlighting.

Pop-up Options

The Pop-up tab controlsthe behavior of pop-up Event alarmsin the

system.

AS-525 AxTrax Software Installation and User Guide Page 84



Administrator Operations

Options

General Pop up L User Fields T Report file

I™ Enable pop up alam window.
Enable pop up user window (Server application anly).

Events

I~ Access Granted Closed by

I~ Access Denied  Manual

I~ hcoess Recordsd  Timer ) e
Display window

€ Standard user window

@ Laige picture

oK Cancel

Figure 68: Pop-Up tab

The Pop-up tab contains the following fields:

Field

Description

Enable pop-up
alarm window

Enable this checkbox to activate pop-up alarm
notifications.

Access Granted

Enable this checkbox to display a pop-up notification
whenever areader grants a user access. This option is
only available from the AxTrax server.

Access Denied

Enable this checkbox to display a pop-up notification
wheneverareader denies a user access. This option is
only available from the AxTrax server.

Access Recorded

Enable this checkboxto display a pop-up notification
wheneveran “accessrecorded” event occurs.

This optionis only available from the AxTrax server.

Closed by
Manual / Timer

Selectto close display pop-ups either manually, or after
a set duration.

Display Window

Use to determine which of the User’s windows to pop-
up.

User Defined Fields

The User Fields/Defaulttab controls the fields on the User Fields tab of the
User Properties window and the Valid Data default value. See User
Defined Data, page 50.
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Figure 69: Options Tab
The Optionstab containsthe following fields:

Field Description

Field description  Enter a name forthe new field.
Field type Selectthe type of field.

Add Click to add this field.

Remove Click to delete the selected field.

Default/Valid Time Default time for user access rights to begin and end.
This field is only available when the check box
has been enabled.

Report Title Settings

The Report title tab controls basic presentation preferencesforthe reports
generated by the AxTrax AS-525.

[ Poprp Wzer Fikds Frepant tithe
Company name Legn
Rosslarel
Fort |

Compury detais
Fozsiere Securty Froducts

W Ghow negor e

o | cwes

Figure 70: Report Title tab

AS-525 AxTrax Software Installation and User Guide Page 86



Administrator Operations

The Report title tab contains the following fields:

Field Description

Company Name Enterthe companyname to be shown onreports.

Font Clickto set a font and colorforthe company name.

Company details Enterthe company address.

Show reporttitle Enable the checkboxto display thiscompany name
andlogo onthe reports.

Logo Add / Clear Clicktoselectalogoto be printed onreports.
If alogo has already been selected, clicktoremove it.

9.8 Importing User Data

The Import Data window makes it possible to import userinformation into
the AxTrax database from a standard spreadsheet file.

Iripunt Lbsers prigaesiars borm eadranal He i Al s 85525 Dok ype:
Excel Werkbook -~ 3|
Encel fie

Staned from

Excelfle Fiow  User Number staried home  bnport depariments? Clepartment
f I e 1 No

Enced e Cobamr

™ % Fasl name T Matde Ll S
™ % Lot v I B Fm LT

™ T - Mk i I H-Emal I M'-Hotes

™ T Depastmant 1 -Addess ™ W - Pl Cods

™ T'- Telaghore ™ - Home telighore

Figure 71: Import Data
The Import Data window contains the following fields:

Field Description

Data Type Selectthe type of data toimport.

Location The location of the file to import.

Browse Click to select the file to import.

Excel file Row Enterthe firstrow of user data in the spreadsheet.
User number Enterthe numberfrom which to start assigning unique
started from system usernumbers.
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Field Description

Import Select Yestoimport new departmentsinto the AxTrax
Departments? database.

Select Notoimport users without their departments.

Department Selectthe departmentto assign to the imported users.
This boxis only active when the Yes buttonisselected.

Excel File Enable the columnsto be imported.
Columns Datain each column (A—M) will be imported aslisted.
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Appendix A. Firewall Configuration

The following instructions explain how to configure the standard Windows
Firewall for Wind ows XP.

To configure the firewall:

1. Clickthe My Computericon on the desktop.
The My Computerfolder opens.

2. Selectthe AddressBar and type "Control Panel". Hit the Enter key.
The Windows Control Panel opens.

P Contral Panul
Fla fde Ve Faverter  Tosk b

Qe = 3 - F P seadh [0 Foldes
deckmss | O Corird el

Pick a category
‘;ﬁ Aggarance wnd Themes g Prietars and Othes Hardwars

P
W etk and Tntermet Comestierns User Aucommts
-

=9
4
-
? s Dt i, L i, e eginal
Add or Ermave Programs i i o

. th Sontiuls, Spereh, and A Devices Aceessibily Dpbion

P e e ekt \ fimcurity Centes

Figure 72: Windows Control Panel
3. Clickthe Security Center category.

(If the Control Panelisin "Classic View", click Switch to Category View
inthe top-left Control Panel preferences pane and click the Security
Center category.)

The Windows Security Center opens.
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¥ Windows Security Center FEE

@ Security Center

Het,

a Firewall

4@ Automatic Updates OO

Sty Gartes L Virus Protection ©OH «

Manage security settings for:

Q suamatic Updates (T Wntesnet Options

B Windows Firewal

Figure 73: Windows Security Center
4. Click Windows Firewall.

The Windows Firewall opens.

Selectthe Exceptionstab.

£ Windows Firewall X

General | Exceplions | Advanced

Windows Firewall is blocking incoming netwark connections. except for the
pragrams and services selected below, Adding exceptions allows some programs
10 work belter but might increase yaur secuit risk,

Programs and Services

Name -
H004_C

[ Application Sharing

PO Corfiguration Utiity

ey

DHCF Discovery Service
Digi0p RemoteM anager Appiication
DigiT ool Call Center

File: and Printer Sharing

ftpcomm

WA Intalinent 1P Inctalar

3

[[addPogiam.. | [ AddPor. ][ Edt | [ Delete

Display & nolifisation when Windows Firswal blocks = program

What are the risks of sllawing exceptions?

Figure 74: Windows Firewall
5. Click Add Program.
The Add a Program dialog appears.
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Add a Program E|

Ta allow communications with a program by adding it to the Exceptions list.
zelect the program, or click Browse to search for one that is not listed.

Programs:
) Solitaire -~
& Spider Solitaire
_] SGL Server Eror and Usage Reporting
(51] 6L Server Suiface Area Configuration
i TransferlseiD ata
@ D Agent
I Uninstall
D Urirstall DeepBurer
x SOL
I wirlmage
Bwow 5

Pathy | C:\Program Files\Rosslare\VeritraxSOL\WeriTr:

Figure 75: Add a Program to the Firewall List

6. Click Browse.
The Browse dialog appears.
7. Inthe File Name box, type:

"G:\Program Files\ Microsoft SQL
Server\MSSQL.1\MSSQL\BINN\sqlservr.exe"

Hit Enter.
The sqlservr program appearsinthe Add a Program dialog.
8. Selectthe program and click OK.

The sqlservr program appears on the Windows Firew all list of
exceptions.

9. Repeatsteps5and6.Inthe File Name box, type:
"C:\Program Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe"
Hit Enter.
The sqlbrowser program appearsinthe Add a Program dialog.
10. Selectthe program and click OK.

The sqlbrowser program appears on the Windows Firewall list of
excenptions.

Click OK.
11. Repeatsteps1and 2.
The Control Panel window opens.
12. Click the Performance and Maintenance category.
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(If the Control Panelisin "Classic View", click Switch to Category View

inthe top-left Control Panel preferences pane and click the
Performance and Maintenance category.)

The Performance and Maintenance window opens.

# P = and Mainlenance

Fla Bt Vew Fewrte Tok e

Qs = 3 - (F O Sewch i Fders
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See Alss
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or pick a Control Panel icon

PP dmicistrotive Teols B2, powrer Options

‘ schebied tasks QAL Syvtem

Figure 76: Performance and Maintenance window
13. Click Administrative Tools.
The Administrative Tools window opens.

" Administrative Tools (=]
Fie  Edt View Favortes  Toos  Help &

Queck = O - (T | Fosearch [rolders | [

v B
ol i ]
Pl e s - W
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£ Share this Fokder : S
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) My Dosuments

3 Shaeed Documerts
i My Computer
N My hskwork Flaces

Figure 77: Administrative Tools window

14. Double-click onthe Servicesicon. The Services Console opens.
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% Services
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Figure 78: Services Console

15. Right click on Windows Firewall/Internet Connection Sharing (ICS).
Click Restart from the pop-up menu.

16. Right click on SQL Server. Click Restart from the pop-up menu.

17. Right click on SQL Server Browser. Click Restart from the pop-up menu.
The Firewallisnow configured for AxTrax AS-525.
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Appendix B. SQL Service Settings

In ordertoreach the SQL Service Settings, click on the following path from
the Control Panelin Windows XP:

Control Panel > Administrative Tools > Services and Applications > Services
> SQL Server (VERITRAX).

Double click on "SQL Service (VERITRAX)" to receive the following dialog:

SQL Server (VERITRAX) Properties (Local Computer) @g

General | Lag On | Recovery | Dependencies

Service name: MESALEVERITRAX

Display name:

Description: Provides starage, processing and controlled access of
. dlata and rapid transaction processing

Path to executable:
"CHiProgram Files\Microsoft SQL ServeAM3ISOL 1S SALBInmsglserr.exe" -5

Startup type: Automatic v

Senvice status: Started

Stop ] [ Pause

“ou can specify the start parameters that apply when you startthe senvice from
here

Figure 79: SQL Service Settings

Underthe Generaltab, verify that the Startup typeis “Automatic” and
that the Service statusis “Started”
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SQL Server (VERITRAX) Properties (Local Computer) @g|
General| Log On | Recovery | Dependencies

Logonas
@®Local System accaunt
[ Allow service to interactwith deskiop

(O This accaunt

You can enable or digable this senvice for the hardware profiles listed below:

Hardware Profile Service
Profile 1 Enshled

Figure 80: SQL Service Log On

Inthe Log Ontab, verify thatthe Local System Accountradio button is
selected. If not, selectthe Local System Account and restart the
computerforthe changesto take effect.
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Appendix C. Network Configuration

The AxTrax Server connectsto access control units by a serial connection,
aTCP/IP connection ora Modem-to-Modem connection.

To connectaccess control panelsto the AxTrax AS-525 over a TCP/IP LAN

(Local Area Network) or WAN (Wide Area Network), the use of a TCP/IP to
Serial convertersrequired unlessthe panelhasonboard TCP-IP connection
(AC-225IP or AC-525).

EachTCP-IP connection can supportsup to 32 access control panels
connected using RS-485 with each other.

The hardware used to connectto TCP-IP network may be the MD-N32
whichis a Serial to Ethernet converter, or using the onboard converter of
AC-225IP or AC-525.

You can also use Rosslare’s MD-N33 modem for Modem to modem
connection. Referto the hardware installation manuals of the desired
panel for more details.

TCP/IP and Modem-to-Modem connections must be configured for use,
and require expert knowledge of the local network.

To configure TCP-IP Connection for AxTrax AS-525:
ij

1. Inthe tree view, click on Networks. Click the Editicon onthe
toolbar. The Networks window opens.
2. Setthe Networktype asTCP/IP.
Note:
* If you want to work with Remote in TCP/IP Network wind ow
. select Remote (WAN), and add the WAN IP Address of the PC.

3. Clickthe Configuration button.
The TCP/IP Configuration window opens.
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TCP/IP Configuration

Canfiguration
MWD - N32 list [ Status | Corfiquration
: Gateway Typs
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Eie
255 I 255 . 255 ) il
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R =
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G7600 | 1000

Apply

Seaich options
" Direct MAC addiess

[ & & & 8 B
" Direct IP Address ,7 ,7 ,7 ) ]7
& Al MD-NI2
ok Cancel
Figure 81: TCP/IP Configuration window

The upperleft window lists all TCP/IP converters attached on the local
network, identified by their MAC address, and if they are available to
assignto a new panelnetwork or are already assigned.

4.

Selectthe appropriate MAC address from the MD-N32 list (The MD-
N32's MAC addressshould belabeled onthe TCP/IP converter).

In"Gateway Type"selectthe type of TCP/IP converter, MD-N32, MD-
IP32 On board, or any othervalid option. Skip this selection if it is
already valid.

Inthe appropriate fields, enterthe LocalIP address and Subnet for
the computer's network.

Enterthe Port number and selectthe speed of your connection. Itis
recommended to select a highervalue port number (4001 or higher).
Note thatthe selected should not end with zeros (prefersetting Port
value of 4243 rather than 4200). This will avoid colliding with port
addressesreserved forvarious equipmentinstalled on the same
network.

Click OK to start the verification process.

Click OK twice and verify that the AxTrax AS-525 software accepted
the configuration.

Turn off the MD-N32 power (or panel powerif using the onboard
module,such as MD-IP32) and than turn power on again. This step is
necessary when using certain versions of MD-N32 or MD-IP32 models.
Skip thisstep if not applicable.

If configuration appliesto WAN network, disconnectthe configured
unitfrom the local network and re-connectto the WAN network and
access control panels network working overthe WAN.
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To configure MD-N33 in AxTrax:

1. Add anew networkin AxTrax software.

2. Undernetworktype select Modem.
retworke =

Descaption
Medvace. 3 1z | m

W Enabind

Hebywork bype
[Modem =|
Modem Nebveost,
Com Forl
|com: =

Spend

T —

Figure 82: AxTrax AS-525 Modem Network

Note:
* Communication speed islimited to 9600, 19200, 57600, or 115200
& bits persecond.

To Initialize and Configuring the Computer Modem
1. Inthe Network window, click the Configuration button.
The Modem Configuration window opens.

Modem configuration 3]
PC modem 1 Rematz mokm
Digling
Remote madem phone number
Nurnber of dial stterpts
1 -
Additianal disling string aptions:
[ W Use defauk
Dialing +chedule -
[Hever =
-
Settings
Iritislization string
[ W Use default
Apply
Ok Cancel

Figure 83: AxTrax AS-525 Computer Modem Configuration
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2.

10.
11.

In the Dialing area, under Remote modem phone number, enter the
destination telephone numberto call.

Clickto change the Number of dial attempts (if re quired).
For most applications, the default dialing string is sufficient.
The dialing string is displayed in the window.

Clearthe Use default checkbox. This allows adding or editing of the
dialing string. Then type the AT command in the Dialing string
window.

Selectthe time zone from the Dialing schedule drop down list.

Choose the disconnecting condition: "Disconnect by schedule end"
or"Disconnectonupload complete".

(This optionis enabled when the selected time zone is different from
the defaulttime zone (Always & Never).

In the Settings area the initialization string is displayed in the window.
For most applications, the defaultinitialization string is sufficient.

Clearthe Use default checkboxto allow adding or editing of the
dialing string. Then type the AT command in the Dialing string
window.

Connectthe computer's modem to the PC via the selected COM
port and click "Apply" to initialize the PC modem.

Click OKto complete the initialization.

If the computer displays a failure message, checkthe modem
connectionsand repeatthe laststeps.

Note:

Remote modem initialization is at the PC side. When modem
initialization fails through telephone line, a message appears.

Initializing and Configuring the Remote Modem
To initializing and configure the remote modem.

1.

Inthe Modem Configuration window, clickthe Remote modem tab.
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Figure 84: AxTrax AS-525 Remote Modem Configuration

2. Inthe Settings area the initialization string is displayed in the window.
For most applications, the defaultinitialization string of AS-525 is
sufficient.

3. Clearthe Use default checkboxto allow adding or editing of the
dialing string. Then type the AT command in the Dialing string
window.

4. Setthe numberofrings before the computer modem answers.

5. Connecttheremote modem to the computervia the selected com
port and click Apply to initialize the computer modem.

6. Click OK to initialize.

7. If a failure message appears, checkthe modem connections and
repeatthe last steps.

Note:
* You must perform the action twice atthe PC side, to Initialize
& two MD-N33’s.

The MD-N33 and AxTrax AS-525 software are now configured and ready.
(You cannow continue working using the AxTrax Adding New Panel
procedure).

To check the remote modem status:

1. When panelissettingin a modem network, you can see the status of
the modem by clicking the phone iconinthe toolbar.

2. Thereisa manual option to dial or disconnectthe modem.
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Hetwark | Phone number | Status | Duration |
Metwork 4 102 Connected 2 Minutes
Metwork & 104 Connested 2 Minutes

Discannect | Close |

Figure 85: AxTrax AS-525 Modem Status

3. Inorderto preventaccessto AxTrax data from non-authorities users,
the AC-215, AGC-225 or AC-525 access control panels contain a
password that can be changed only whenthe modemis connected
and there is a link with the panel.

Note:
b The default password forthe modem configuration and status
. screensis VeriTrax.

You may be asked to enterthe password during first data
configuration, such as adding a new panelordownloading a new
firmware.

Confitm modem password for the network Metwork 4

Cunent Password:

MNew Password:
Confirm New Password:
T

0K | Cancel |

Figure 86: AxTrax AS-525 Modem Security

Restoring Factory Default Settings

Ifthe modem configuration password is lost or forgotten, reset the access
control panelto the factory default settings and use the default"VeriTrax"
password.
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Caution:

Restoring factory default settingsresets alldoors and reader
configurations to theirfactory defaults and clears all user
properties.

To restore the factory default settings:

1.
2.
3.

Turn off the supply power.
Disconnect alldoors and readers wiring.

ConnectData 0, Data 1 and Tamperinputsto GND (-)in bothreader
1 and 2 (total of 6 wires)

Powerup the supply powerforfew seconds. Wait forthe "LED3" and
"LED4" LEDs to flash alternately.

Turn off the supply power.
Connectthe doorsandreaders wiring again.

In AxTrax AS-525, delete the panel by clearing the Enable panel
checkboxinthe panelscreen. Click OK.

Checkthe Enable panel checkboxinthe panelscreen and click OK.
This action causes a fullreset of the access control panel with the
factory settings.

Dialto the appropriate access control panel and click on password in
the modem status screen. Use AxTrax asthe current password and
change the password to a new one.
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Appendix D. Technical Support

Asia Pacific, Middle East, Africa
Rosslare Security Products Headquarters

905-912 Wing Fat Industrial Bld g,

12 Wang TaiRoad,

Kowloon Bay Hong Kong

Tel: +852 2795-5630

Fax: +852 2795-1508

E-mail: support.apac@rosslaresecurity.com

United States and Canada
1600 Hart Court, Suite 103
Southlake, TX, USA 76092
Toll Free: +1-866-632-1101
Local: +1-817-305-0006
Fax: +1-817-305-0069
E-mail: support.na@rosslarese curity.com

Europe
GlobalTechnical Support & Training Center
HaMelecha 22
Rosh HaAyin, Israel 48091
Tel: +972 3 938-6838
Fax: +972 3 938-6830
E-mail: support.eu@rosslaresecurity.com

South America
Pringles 868, 1640 Martinez

Buenos Aires, Argentina

Tel: +54 11 4798-0095

Fax: +54 11 4798-2228

E-mail: support.la@rosslarese curity.com

Web Site: www.rosslaresecurity.com
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